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OneCNC Mill is a hybrid CAD-CAM system with a user-friendly 
interface.  OneCNC Mill simplifies the process of defining toolpaths for 
the machining of parts using CNC milling machines with up to 5 axes.

OneCNC integrates the Microsoft Windows interface with a powerful 
CAD engine.  Parts can be designed and modeled in OneCNC, or 
imported from 2D or 3D CAD files.  The part model and geometry 
data is directly available to the inbuilt CAM functions.

The purpose of this Manual
This manual covers OneCNC Mill Expert, Professional, Advantage, and 
Express.  The manual provides information on how to get started and 
use OneCNC, it is not designed as a machining instruction manual.

Much of the information in this manual is also contained in the 
OneCNC Help file, which also contains tutorials and reference 
information about available procedures and commands.

OneCNC Mill
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OneCNC Environment

OneCNC has been designed as an integrated manufacturing 
environment, with purpose built interaction between the CAD and 
CAM functions.

New users familiar with Windows-based software will be at home 
with the well organized pull-down menus, toolbox and shortcut keys 
together with meaningful graphics included throughout the software 
interface.

The interface is similar to other common Windows-based drawing 
software and provides compact access to frequently used functions.  
Users experienced with other mechanical CAD software will appreciate 
the ability to customize the functionality in a way they are used to 
using.

CAD functions
The CAD functions are used to draw and create parts.
Line, arc, and spline geometry can be combined with NURBS surfaces 
and solids in a hybrid modeling process.  As well as the complete CAD 
functions for constructing parts from scratch, robust translators are 
provided for importing parts in other formats.  2D drawing and 3D 
modeling methods have been designed for ease of use.

CAM functions
The CAM functions are used to create the required NC program 
toolpaths for CNC machining of your parts.  Toolpaths can be edited 
and reviewed in the NC Manager, which also has functions for 
backplot, real time preview, and metal removal simulation.

Multiple Views
OneCNC can show single or multiple views of the same object or 
model.  Any view can be dynamically panned, rotated or zoomed.  
Multiple views make it easier for you to create complex models.  While 
in a command it is possible to select a point in one view and then 
select the next point from another view.

Multiple Document
You can have more than one part drawing open in OneCNC. This 
makes it easy to cut and paste from one drawing to another and 
toggle between drawings.  The Recent File tab shows previews of 
files to help you quickly find the drawing you want.  Document 
management is simple in OneCNC due to the fact that the CAM data is 
stored in the drawing file.
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OneCNC Installation

Minimum System Requirements

Operating System
Microsoft Windows 10, 8, 7, Vista or Windows XP (32 or 64bit)
Internet Explorer 7 or later
NTFS File System is recommended

Hardware 
Minimum 1 GB of quality memory for Windows XP, or 3 GB of quality 
memory for Windows 8, 7, or Vista, especially if working with complex 
parts.

Pentium 4 single, dual, or quad core PC.  AMD Athlon can be used 
only if later than 2004 with specs equal to the Pentium 4.

NVIDIA GeForce or similar OpenGL and DirectX graphics card, 
minimum 1Gb.  It is essential you download and install the latest 
graphics driver for your card, as drivers supplied on install discs may 
be outdated due to production lead times.

A mouse with 3 or more buttons and a scroll wheel.
One available USB 1.1 or 2.0 port or a suitable parallel port depending 
on which licensing dongle you have.
CD-ROM drive for installation of standalone version if required.
Broadband Internet access is recommended for updating the 
software.

OneCNC Installation

You will need:
OneCNC installer disk or a downloaded update setup file
OneCNC dongle
CD Key and serial number

There are three steps to installing OneCNC on a single computer:
Install the software from disk or an update setup file
Plug in the dongle
Run OneCNC and enter the serial number to activate it

For network installations, network server software must be installed 
as well.  That process is outlined in the next chapter.
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All OneCNC products can be installed from the one installer package.

Insert the OneCNC CD or plug in the OneCNC flash drive. 
Display the drive contents in Windows Explorer and double click 
‘onecnc_setup.exe’

Language Selection
Select your language from the drop down list.

Units Selection
Select the units you work in, Metric or Imperial (inches).  This will set 
the default drawing units and post-processor configuration units.  The 
units setting can be changed after installation using the Properties 
dialog on the File menu.
One CNC will open a file drawn in the alternate units at the correct 
real world size, but the NC toolpaths will be invalid, so you should 
save the files to separate locations.

CD Key
OneCNC installation requires a CD Key, which is usually found on 
the inside rear cover of this manual with your serial number, but is 
sometimes shipped separately from the software for security.
Enter the CD Key and click the large ‘play’ button to start the 
installation.  

The serial number will be requested when you first run the software.    
Keep a copy of your CD Key and Serial in a safe place as you will 
need them if you upgrade your computer and need to re-install.
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The next dialog advises you to have all other programs closed, which 
is standard software installation procedure.

You then have the choice of where to install OneCNC.  You can accept 
the default location or click the Browse button if you want to select 
your own location.  Click Next when you are ready to continue.

In the confirmation dialog you can click Back to review your settings, 
or click Next to install OneCNC.

If you are upgrading from a previous version of OneCNC, the new 
installation will be in a new location.

You can still use your existing tool and material libraries, and 
custom Posts.  To do this, copy the Settings folder from your 
previous installation to your new installation Settings location.

It is good practice to keep a backup copy of your Settings folder.
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OneCNC Updates

Registered users can download updates of the setup file for their 
version of OneCNC at no extra charge.

Go to http://onecncsupport.com/ and click on OneCNC Updates 
when you have read the update details.
Click on Check For Updates.

Enter your dongle and serial numbers to enter the site.  Click on the 
Register button on the next page to appear.  Fill in your registration 
details, and click Save.  Click on the Download button to go to the 
actual download page.

Select the check box to confirm you have read the update details, 
and click on the Download button.  A dialog will appear asking if you 
want to Run or Save the file.  Select Save and choose the folder on 
your computer to save the file in.  Double click the downloaded file 
to install the update.

The update can also be accessed by clicking on OneCNC Updates in 
the Help menu, or the OneCNC Software Updates, Drivers and Posts 
link in the OneCNC Users Forum.

When all the files have been installed, click Finished to complete the 
installation.  There will be a pause while the dongle driver for Series 1 
dongles is installed.

When the installer closes, you are ready to insert the dongle and start 
OneCNC.
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Dongle Installation

OneCNC requires a dongle for the licensed program to run.
A dongle is a small hardware device which verifies your software 
license.

Series 2 Dongle Installation - dongle numbers from 10000

All OneCNC dongles with a number higher than 10000 are Series 2 
dongles.  

Series 2 dongles are USB HID devices which look like this.  These 
dongles do not require drivers for a single computer installation.

If you have a network license you will need to install a network dongle 
driver, as described in the next chapter.

To install a Series 2 dongle
Make sure OneCNC is not loaded or attempting to load.  To install the 
dongle simply plug it into a USB port on your computer.  Basically, if 
the dongle fits, it’s the correct port. Do not try to force the hardware 
or you may damage your computer or dongle.

If you have a timed licence the Windows date and time must be 
correct before connecting the dongle.  It is recommended that the 
USB port a dongle is plugged into should not be used for other 
devices.

Dongle Security

Because it is the dongle which verifies your purchase of OneCNC, 
if a dongle is accidentally damaged or broken the damaged dongle 
must be returned to OneCNC before a replacement dongle can be 
issued.

If a dongle is lost or stolen, the replacement price is the full price 
for the software.  Take steps to secure your dongle, and insure it for 
the replacement cost of the software.
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Series 1 Dongles - dongle numbers 1 to 9999

If you have upgraded from an earlier version of OneCNC, you may 
have a Series 1 dongle with a number less than 10000.

These dongles may be USB or Parallel port dongles, and are now 
obsolete.

There is no 64 bit driver available for these older dongles, so if 
you have a series 1 dongle please see your OneCNC dealer for a 
replacement series 2 dongle.

A series 1 dongle will be replaced at no extra cost with any upgrade to 
the current version of OneCNC.

Note: 
 
A series 1 dongle will not run the 64bit version of OneCNC.

Until you get your replacement dongle you can install the 32bit 
version of OneCNC on 64bit Windows by changing the last two digits 
of the CD Key to 32.  For example the CD Key 6432 will install 32bit 
Mill Express which can be run with a series 1 dongle.

When you change to a new series dongle re-install OneCNC with the 
standard CD Key.
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Network licence - Series 2 dongle

To run OneCNC on a client PC connected to a network using a Series 
2 dongle, you must select ‘Network licence’.

To run OneCNC on a computer which is also the network server, the 
server installation needs to be set to ‘Single user licence’, as in this 
case the dongle is on the local system and not on the network.

Start OneCNC and enter the Serial Key

Once installation is complete and the dongle is installed, OneCNC can 
be started.  Double click on the OneCNC shortcut on your desktop, or 
select the OneCNC shortcut in the OneCNC folder in the Start menu.

The first time OneCNC is started the Licence Manager will look for 
the dongle.  Select ‘Single user licence’ if you have a standalone 
installation, and click Continue.



Page 14 Introduction to OneCNC Mill ©

The Licence Manager will open so you can enter the licensed user 
name and serial number.

The serial is made up of digits 0 to 9 and letters from A to F.  The 
code must be entered exactly as it appears.

When the serial key has been entered the Licence Manager will 
indicate that the licence is acceptable, and the software can then be 
started.

Entering serials for optional modules

If you have a serial for an optional module, 
start OneCNC and click on Register Modules in 
the OneCNC Help menu.

Enter the serial in the dialog which opens, and 
the module will be activated.
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User profile selection

OneCNC starts with this screen, which gives you the option of 
selecting the user profile you want to use.  The user profile stores all 
your settings such as toolbar layout, interface color settings and your 
recent files list.

Clicking on the small arrow opens the user selection dialog, which 
allows you to select or create settings in the names of specific users 
for customizing.
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Select the user profile you want to 
use from the list, and click OK.

You can create, delete, and 
rename user profiles using the 
buttons below the drop down list.

Click here to start OneCNC 
with the selected user 
profile.

If your user profile or other settings are not being saved, open 
Windows Explorer and right click on your Settings folder.  Select 
Properties, and clear the “Read-only” check box.  Click Apply and 
click OK to apply the change to all subfolders and files.
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This step is only necessary for network installations.

For network installations, network server software must be installed 
on the server or computer the dongle is plugged into.

Series 2 dongles use the OneCNC Dongle Server which is included in 
the OneCNC installer, and is accessed by a CD Key similar to installing 
the OneCNC software itself.  

To install OneCNC Dongle Server on a computer or server with a 
Series 2 dongle, you will need: 

•	 OneCNC installer disk or a downloaded update setup file
•	 OneCNC dongle
•	 Network CD Key and serial number

OneCNC Network Installation
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Run the installer on the server computer.  To install the network 
dongle server software enter the CD Key 60200.

When the next dialog appears, enter the server software serial.  The 
serial is made up of digits 0 to 9 and letters from A to F.
This is not the same as the software serials which are entered later 
when installing the particular versions of OneCNC such as Mill and 
Lathe.
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The next dialog advises you to have all other programs closed, which 
is standard software installation procedure.

You then have the choice of where to install the server software, the 
default installation is as shown.
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The next dialog indicates you will need to unblock the firewall for this 
application only.  Click Finish to complete the installation.

Here is the Windows Firewall dialog where you have to click Unblock 
for the dongle server software to work.  This has no effect on network 
or internet security, it is only allowing any PC on the local network to 
access the OneCNC Dongle Server.
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The server software is now installed and working.

There will now be an icon in the Taskbar at the bottom of your screen, 
indicating the dongle server software is running.

You can click the icon to open the Dongle Server interface, but it is 
not necessary to have the Dongle Server interface open for client 
computers to access the dongle.

The interface allows you to see how many clients are connected to the 
Dongle Server.  You will not see a connection as shown here, until the 
OneCNC programs are installed on the client computers.

To install OneCNC on the client computers, start the OneCNC installer 
on each computer, and load the OneCNC application using the CD key 
for OneCNC.
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Running OneCNC Dongle Server automatically

You can run OneCNC Dongle Server automatically so you do not have 
to start it if the server has been shut down.
Setting up a scheduled task will install OneCNC Dongle Server as a 
service which will automatically restart when the network server is 
started.

Firstly, install OneCNC Dongle Server as shown in the previous 
section.  You can then use the Windows task scheduler to set up 
an action to start the OneCNC Dongle Server when the computer is 
started.  You must be logged on as an administrator to perform these 
steps.

To open the Windows Task Scheduler, open Control Panel, click on 
System and Security, and click on Administrative Tools (if Control 
Panel opens in Classic view you can just double click on Administrative 
Tools). Double click on Task Scheduler.

In Windows Server, open the Server Manager and navigate to Server 
Manager > Configuration > Task Scheduler .

Click Create Basic Task.  Enter the name and description for the task, 
and then click Next.  Select When the computer starts, and click Next.  
Select Start a program, and click Next.  Click Browse to find the 
OneCNC server program, which will typically be at C:\OneCNC Server\
onecnc_server.exe  Click Next when you have selected the program. 
Review the settings you have made and click Finish.

Restart the server to apply the changes you have made.
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The OneCNC user interface has been carefully designed for ease of 
use.

Windows menus give you access to many features in OneCNC.  Menu 
items with a pointer on the right side automatically open sub-menus 
which you can slide the mouse across to select from.

OneCNC User Interface 

The Mill Expert interface is shown in this chapter.  The available 
modeling and CAM functions you see will vary for different types or 
levels of OneCNC.  OneCNC Solid Creator is intended for design only 
and has no CAM functions.
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Drawing Window 

The file you are working on is displayed in the drawing window, which 
is a real-time OpenGL model view.   This allows you to view your 
object by means of dynamic rotation, panning and zooming. 

Multiple Views of the same file can be shown.  When parts become 
complex it can be useful to view and edit one object from various 
angles simultaneously.  This function can be accessed from Window > 
Window Layout.
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Multi Document

You can have more than one file open in OneCNC.  When the file 
windows are maximized you will only see one file at a time.  You can 
select the file to display from the Window menu.

Clicking the Restore Window button will display each file in 
its own window.

The file windows can be controlled by dragging, or using the Cascade 
and Tile commands on the Window menu.
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Toolbox

The Toolbox is a menu system which is shown in the left sidebar.

When you start OneCNC you will see the toolbox 
Home menu.

The Home menu icons are grouped into 
commands for drawing, modeling, and CAM 
functions.

The toolpath functions available will vary with the 
version and level of OneCNC you are using.

Each icon in the toolbox Home menu will open a 
sub-menu from which you can select a specific 
command.

For many commands entry boxes will appear 
where you can input required values.

Click on the Home icon at the top of the Toolbox 
to return to the Home menu.

Clicking on the dotted button at the left of the toolbox will hide it.

Click on the button again to bring the toolbox back into view.
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Right Sidebar

On the right of the screen the right 
sidebar has panels for:

•	 NC manager
•	 Layers Manager
•	 CAD Verify
•	 History
•	 Recent file list

Clicking on the dotted button at the right of the sidebar will hide it.

Click on the button again to bring the sidebar back into view.

NC Manager

The NC Manager displays the 
toolpaths you have defined.

Machining operations can be grouped, 
and operations can be renamed, 
edited, rearranged or duplicated.
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Layer Manager

When you draw an entity it’s created 
on the currently selected layer.  The 
Layer Manager  is used to create, 
name or delete drawing layers.

The panel shows a list of layers in a 
drawing.  You can turn off a layer by 
closing the eye for that layer in the 
Layer Manager.  Entities on the layer 
are still in the drawing but will not be 
visible.

Verify

The Verify panel holds tools to read 
data from geometry.  

You can find exact values for position 
length or area for 2D entities, and 
volume of 3D solids.  You can also 
find the angle and distance between 
entities.

History

As you construct your part, a record 
of commands used is created in the 
History tab.
You can roll construction back or 
forward like a multiple undo and 
redo.  If you roll-back your history 
and start new construction, the rolled 
back construction is replaced with the 
new construction.

Recent Files list

When you save a file, a thumbnail 
image of it is added to the Recent file 
list.
The list shows if a file is open, active 
or closed.
You can open a closed file by clicking 
on the thumbnail image.
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Status Bar

The Status Bar at the bottom of the OneCNC window provides you 
with functions related to the appearance of objects, and a message 
panel which shows prompts to help you use the program.

Preset Views

OneCNC has a set of preset views so you can select the direction you 
want to look at your model from.

Click on the View icon to open the preset view selector.

Click on the icon for the view you would like to 
change to.

For 3D modeling the Isometric or Trimetric Views are 
the most commonly used.

The CAD View is a special view optimized for 2D 
drawing, so it is not suitable for 3D commands.  Use 
the Top View if you want to use 3D commands in a 
view similar to the CAD view.
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Construction Plane

When you draw or model in OneCNC you can use a coordinate system 
which is independent of the world XYZ coordinate system. 
OneCNC displays the Construction Plane which is a visual reference 
for the XY plane of the current construction coordinate system.

The Construction Plane is controlled using the Plane dialog, which 
is opened by the Plane icon in the Status Bar.

The Working With Planes tutorial in this manual covers the use of 
Construction Planes.

Display mode

Display controls the appearance of 3D surfaces and solids. 

Click on the Display icon to open the Display mode selector.

Click on the icon for the display mode you would like 
to change to.

If you are extracting 2D profiles from 3D objects it 
can be useful to use the Transparent or Wireframe 
modes to access obscured parts of the model. 

If you set the display mode to Wireframe, be sure 
to return it to another mode before attempting any 
modeling commands as you will not see any surfaces 
or solids.
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Section Tool

The Section tool is used to view a cross-section of your work 
parallel to the current working plane.  It can also be used to create 
section geometry.

3D to 2D Automated drawing system

In Expert versions of OneCNC and OneCNC Solid Creator you will 
see the Pages icon which opens the automated 3D model to 2D 
CAD drawing system.  This can be added as an optional module to 
OneCNC Professional versions.

Drawing Color and Style selection

OneCNC has a 2 color drawing system.  Color selection boxes 
in the Status Bar set the color for new entities.  The color 
selection box on the left is for geometry and that on the right 
is for surfaces and models.

To select the line style and line thickness for new geometry entities 
click the Styles icon.

Modifying Entities

Click Modify to change the color, line  thickness, line style or layer 
of existing entities.

Select the check boxes for 
the attributes you want to 
change and select the new 
values.
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Quick Access Toolbar

The Quick Access toolbar is a custom toolbar you can use to display 
icons for commands you use often.

When you install OneCNC the Quick Access toolbar will be empty 
except for the Quick Access icon.  Click on the Quick Access icon to 
open the Quick Access customization dialog.

Select the command you want to add in the Commands list on the left 
of the dialog.  A keyboard shortcut can be assigned to the command 
in the ‘Assign hot key’ entry box.

You can right click on an icon you use regularly to add it to the Quick 
Access toolbar.
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Keyboard Shortcuts

OneCNC provides a default set of keyboard shortcuts, which are a 
powerful way of accessing functions quickly by pressing a key or 
combination of keys.  You can add your own keyboard shortcuts in the 
‘Assign hot key’ entry box of the Quick Access dialog.

The following lists give the default shortcut key settings in OneCNC.

View shortcuts
Arrow Keys			   Rotate model horizontally and vertically
Arrow Keys + Shift		  90 Deg steps rotate right left up down
Ctrl + Arrow Keys		  Pan
Space Bar			   Preset View selection dialog
Space Bar double press	 CAD View
Delete			   Delete selected entities
F				    Zoom to fit
Z + Shift			   Zoom in
Z				    Zoom out
W				    Zoom to a window
Ctrl + 1			   Top View
Ctrl + 2			   Bottom View
Ctrl + 3			   Left View
Ctrl + 4			   Right View
Ctrl + 5			   Front View
Ctrl + 6			   Back View
Ctrl + 7			   Isometric View
Ctrl + 8			   Trimetric View
Ctrl + 9			   Dimetric View
Ctrl + 0			   Default View

Drawing shortcuts
P				    Point
L				    Line
R				    Rectangle
O				    Offset
H				    Hatch
C				    Circle with given radius
Ctrl + F			   Fillet Arc
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File shortcuts
Ctrl + N			   New file
Ctrl + O			   Open file
Ctrl + S			   Save file
Ctrl + Tab			   View next open file
Ctrl + P			   Print

Edit and modify shortcuts
S				    Select Single
L				    Select nearest line when in Single Select 
mode
A				    Select nearest arc when in Single Select 
mode
Ctrl + A			   Select All
Ctrl + Z			   Undo
Ctrl + Y			   Redo
Ctrl + X			   Cut to clipboard
Ctrl + C			   Copy to clipboard
Ctrl + V			   Paste from clipboard
Ctrl + D			   Delete
M				    Move
B				    Blank selection
T				    Trim One
Ctrl + T			   Trim Two

Mouse Actions

Left Button			   Enter / Select
Right Button			  Escape / End Function
Mouse Wheel		  Zoom to/from cursor
Middle Button + Ctrl		 Pan
Middle Button		  Rotate view
Middle Button + Shift	 Zoom
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The purpose of OneCNC is to create NC code programs for CNC 
machines.  The workflows for the various types of OneCNC are as 
follows:

OneCNC Mill or Mill with Multi-axis module
1.	 Draw or import part geometry or model
2.	 Define toolpaths to cut the part
3.	 Preview or simulate to verify toolpaths
4.	 Output NC program to send to the machine

OneCNC Lathe
1.	 Draw or import part geometry or model
2.	 Define toolpaths to turn the part
3.	 Preview or simulate to verify toolpaths
4.	 Output NC program to send to the machine

OneCNC Lathe with Mill-Turn module
1.	 Draw or import part geometry or model
2.	 Define turning and live tooling toolpaths
3.	 Preview or simulate to verify toolpaths
4.	 Output NC program to send to the machine

OneCNC WireEDM
1.	 Draw or import part geometry or model
2.	 Define wirepaths to cut the part
3.	 Preview to verify wirepaths
4.	 Output NC program to send to the machine

OneCNC Profiler (Nesting for plasma, laser, waterjet or router)
1.	 Draw or import part geometry
2.	 Add part shapes to the Parts list
3.	 Nest parts to sheets
4.	 Define drill, engrave and cutting operations for the nested sheets
5.	 Preview to verify toolpaths
6.	 Output NC programs to send to the machine

OneCNC Overview 
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2D and 3D Geometry

Geometry drawing
OneCNC parts are constructed using pure geometry.  Boundaries can 
consist of lines, arcs or splines constructed in 3D space.

Layers
The Layer Manager sidebar panel is used to create, select, open and 
close layers which are used to organize your drawing.

Dimensions and Text
All 2D and 3D geometry can be dimensioned and annotated.  
Text labels can be added to parts and converted to geometry for 
engraving.

Drawing Layout Patterns
Borders, title and revision blocks, and bill of material lists can be 
saved as patterns and loaded into drawings as required.

3D to 2D Technical Drawing System
Expert versions of OneCNC include the 3D to 2D drawing system 
which automates the preparation of 2D drawings for printing.  2D 
technical drawings are created as page layouts in your ONECNC file, 
using title block and border templates.  2D views of the 3D part model 
can be created automatically and added to a technical drawing.
The system can be added to Professional versions of OneCNC as an 
optional module.
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3D Modeling

Available in OneCNC Expert and Professional versions

Surfaces Creation
Planar and curved surfaces can be constructed using the many 
available strategies.

Solids Creation
Solids creation from Primitives allows you to create basic shapes such 
as Cubes, Spheres, and Cylinders.  Solids can also be created by 
revolving or extruding geometry.

Hybrid Solids Creation
In the hybrid modeling technique a closed set of surfaces can be 
unioned to become a new solid.  Existing solids can be merged with a 
closed set of surfaces to become a new solid.

Model Operations
New solids can be created by the cutting, uniting or intersection of 
existing solids.  Solids can be split by a plane, or broken into separate 
surfaces.

Expert Tools
Expert versions of OneCNC have additional advanced modeling tools.
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Toolpathing

In all versions of OneCNC except Solid Creator, toolpaths can be 
defined by clicking an icon in a Toolpaths menu in the Toolbox and 
completing any selection or settings entries that the toolpath requires.  

Toolpath management

When you define a toolpath it will be 
added to the active toolpath group in 
the NC Manager.

An NC file can be output from a single 
operation, all the operations in a 
single group, or all operations in all 
groups in the NC Manager.

Right clicking on a group or toolpath 
will open a context menu with 
commands for frequently used 
functions such as preview and 
backplotting.

In Mill or Lathe the lower section of 
the NC Manager displays settings for 
the currently selected toolpath which 
can be edited.

Toolpath Backplot

Toolpaths can be backplotted, which means they are drawn as 
geometry on a special layer named Backplot.  Feed moves are drawn 
in green, and rapid moves in orange.  Reposition moves in highspeed 
machining are drawn in blue.
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Toolpath Preview

The Live Preview window shows an animated preview of the toolpath, 
backplotting as it goes.  In Mill or Lathe the cutting tool will be shown 
traveling along the toolpath.

Metal Removal Simulation (OneCNC Mill and OneCNC Lathe only)

In all levels of Mill and Lathe, OneCNC provides real-time toolpath 
metal removal simulation.  By simulating the feed and speed of the 
process, you can check the machining operation prior to sending to 
the CNC machine.

OneCNC Mill also provides Rest Material Verification, which highlights 
the thickness of material left on the part until it is fully machined.
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Outputting NC Files

Clicking the Process icon in the NC Manager opens the NC Processing 
dialog.  You can enter notes or a program number before the file 
is output.  OneCNC formats the NC file using a machine specific 
definition called a ‘Post’.  OneCNC is supplied with Posts for all popular 
machines, and it is easy to create a custom Post by copying and 
editing an existing format.

Editing  and sending the created program
When you output the NC file for your job it will open in OneCNC Link, 
the complete editor and DNC transfer program, where you can see 
your NC code before the final stage of sending the completed NC 
program to the CNC machine.
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OneCNC Integrated Help 

At OneCNC we put a lot of effort into making OneCNC the world’s 
easiest CAD/CAM package to use.  OneCNC has several features 
within the program to help new users quickly adapt to its powerful but 
easy to use features.

Help

If there is a specific part of the program you 
want to learn about, click on Contents in the 
Help menu.

The help files will open in a new window, 
with navigation controls at the top.
The Back or Forward buttons allow navigation 
between help files you have visited, like 
an internet browser.  The Home button will 
return you to the first page shown on the 
screen. 

Tutorials

Clicking on Tutorial in the Help menu will 
take you straight to the OneCNC Tutorials 
folder in the Help files.

There are step by step tutorials for 2D CAD, 
3D modeling, and how to define machining 
toolpaths for each version of OneCNC. 

Context Sensitive Help
OneCNC uses Context Sensitive help.  This means if you are using 
a function and need help on it, press F1 and OneCNC Help will open 
showing the relevant topic.
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OneCNC CAD Tutorial 1
Introduction To Cad Drawing

This Tutorial is designed for all OneCNC products.

This tutorial will quickly take you through the essential functions for 
drawing and modifying geometry in OneCNC, to get you up to speed 
in the shortest possible time.  In the exercises in this chapter, exact 
positioning is not important.  The aim is to get an overall view of the 
process of drawing in OneCNC.

Start a new drawing

When you start OneCNC you will have a new file ready to draw in.

You can also start a new file by clicking on the New File icon in the 
Standard toolbar.

The first thing you should do when starting work in a new file is 
to click Save and save the .ONECNC file.  If you save this tutorial 
you will be able to open it and resume where you left off if you are 
interrupted.

It is good practice to save your file regularly as you work.  When 
working on complex parts, you can use the Save As command on 
the File menu to make incremental copies of your work, saving as 
“file_01.ONECNC”, “file_02.ONECNC”, and so on.

It is strongly recommended that you save a backup of all your work 
in another location once a day, and in an offsite location every 
week.
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The part will open in the default 3D view.  The darker rectangle is the 
construction Plane, which indicates the XY plane of the coordinate 
system you will be drawing in.  Later you will see how you can move 
and rotate the Plane to define a new coordinate system but for now 
we will leave it in the default XY position.

Lines

We will start with lines, the most common drawing entity.

Click on the Line icon to open the Line menu in the toolbox.

The Line icon in the Line menu is highlighted, 
showing that the Line command is started 
automatically.

When the Line command is active, coordinate 
entry boxes will be available in the toolbox.  
Coordinate entry can be used for the first or 
second point of any line segment.

You can enter coordinates for a position in the 
World coordinate system, or the coordinate 
system of the current plane.

The current mouse pointer position is 
displayed in the toolbox, so you can also use it 
to check the position for a grid snap. 
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The mouse pointer will snap to grid positions in the drawing plane.
Click to select a start point for the new line.

The mouse pointer will have a preview of the line to be drawn 
attached to it.  Click on a new grid point to draw a horizontal line.

The Line command draws consecutive lines.  Click again to draw a 
vertical line from the last point.
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Move the mouse pointer horizontally again and you will see an 
indicator line when the new line endpoint is aligned with the start 
position.  Click to end the line on the vertical alignment.

Hold the mouse pointer near the start of the chain of lines and you 
will see the Endpoint indicator.  Click to end the new line on the first 
line endpoint.

Hold the mouse pointer near the previous line and you will see the 
Midpoint indicator.  Click to end the new line on the previous line 
midpoint.
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Right click to end the chain of lines.

The Line command will still be active.  You can start a line at a new 
position and continue as before.

Click near a line you have already drawn.  The start point will be on 
the existing line.

The toolbox will display the distance the new 
start point is along the existing line.

Change the value in the Distance along entry 
box to move the start point to a new position 
along the base line.

If you prefer you can enter the position on the 
base line as a ratio of the base line length.

The Distance along and Ratio along values are 
interactive.



Page 47Introduction to OneCNC Mill ©

Move the mouse pointer near another line and click to connect to it.

Right click twice to end the Line command.

Click on the Select All icon to select the lines you have just drawn.

Click the delete icon to clear the drawing area.

Start the Line command again and practice drawing lines.
You can enter an exact position for a line endpoint by entering 
coordinates in the toolbox.  You can also define a line by entering a 
value for line length, or angle from the last line segment.

Delete the lines when you are ready to continue.
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Rectangle

The Rectangle command creates a rectangle with the option of a given 
radius fillet on all the corners.

Click on the Rectangle icon in the Line menu to start the Rectangle 
command.

When the command is started, you have the 
option of entering a corner radius value.

Enter a Corner Radius of 5.

To define the first corner of the rectangle you can click on an entity or 
grid snap, or enter coordinates in the Toolbox.

This will be the point where the sides of the rectangle intersect before 
they are filleted.
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A preview of the rectangle is shown, with the second corner attached 
to the mouse pointer.  Click on or enter a position for the second 
corner.  The second corner can also be set by entering an X length 
and Y width for the rectangle. 

The mouse pointer is still active, ready to select a start corner for a 
new rectangle.

Draw some more rectangles, using different options such as a zero 
Corner Radius, or using values for Length or Width.

Right click when you are ready to end the command.

Click on the Select All icon to select the rectangles you have just 
drawn.

Click the Delete icon to clear the drawing area.
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Circles

The Circle command creates a Circle with a given diameter.

Click on the Arc icon to open the Arc menu in the toolbox.

The Circle icon in the Arc menu is highlighted, showing that the Circle 
command is started automatically.

Enter a Diameter for the circle in the Toolbox.  

A preview of the circle is attached to the mouse pointer.

Click on or enter a position for the center of the circle.
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The Circle command continues and you can place another circle by its 
center point.

You can change the Diameter in the Toolbox before placing the next 
circle.

Right click when you want to end the Circle command.

Click Select All and then click the Delete icon to clear the 
drawing area.
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Offset entities and boundaries

An offset entity or boundary is often needed when drawing a part.
In OneCNC this is done using the Parallel/Offset command.

To practice the Parallel/Offset command, draw a rectangle with filleted 
corners.

Offsetting single entities

Click on the Parallel/Offset icon in the Line menu to start the 
command.

When the command is started, enter the 
distance you want to offset in the Offset 
Amount entry field in the Toolbox.

Select a side of the rectangle.
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Move the mouse pointer around, and you will see a preview of the 
selected entity being offset.  When the preview is where you want the 
offset, click to create the offset entity.

You can now select another single entity, and create an offset by 
clicking when the preview is where you want the offset.

Right click to end the command when you have finished making 
single offsets.
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Offsetting a boundary

Delete the single offsets you made, or click on Undo till you return to 
the rectangle with filleted corners.

Click on the Parallel/Offset icon in the Line menu to start the 
command.

Enter the distance you want to offset in the 
Offset Amount entry field in the Toolbox.

Select  the same side of the rectangle.
The single offset preview will appear, but do not click to place it.
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Move the mouse pointer near the end of the selected line, and the 
connected boundary will be highlighted.  Click to select the boundary 
for offsetting.

Now the preview will show a preview of the entire boundary being 
offset.  Click to place the offset.  The command will recur.

Right click when you have finished creating offsets.

Select All and Delete before continuing.
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Moving Entities

Entities can be moved, copied, scaled, rotated and mirrored.
These Transform functions can be accessed by clicking on the 
Transform icon in the Toolbox to open the Transform menu.

We will start with the Move command.  Use grid snaps to draw a 
square evenly spaced around the world origin, and draw two circles 
on the corners at the left of the square.

Before starting a Transform command, entities must be selected.
Click on the Select icon to select entities one at a time.

Click on each of the circles to select them.  Selected entities change 
color to red when they are selected.  If you select an entity by 
mistake, click on it again and it will be removed from the selection 
set.

Right click to finish selecting.
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Click on the Transform icon to open the Transform menu in the 
toolbox.

The Move icon in the Transform menu is highlighted, showing that the 
Move command is started automatically.

You can select or enter a position as the start point for a move.  Click 
on the midpoint of the line between the circles.

A preview of the entities being moved will be attached to the mouse 
pointer.  Shadows indicate the original position of the entities.  Click 
on the midpoint of the opposite line to move the circles.

Right click to end the Move command.  The moved entities are 
still selected, ready for another command.
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Click Deselect All to leave the circles unselected.

Copy Entities

Click on the Select icon, and select the circle at the top of the square.

Right click to end the selection.

Click on the Copy Move icon in the Transform menu of the toolbox to 
start the Copy command.
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Select the intersection of the circle and the right side of the square as 
the start point of the move.

Move the mouse pointer to the left side of the square.  Click on the 
intersection of the left side of the square and the dashed horizontal 
indicator to set the finish point of the move.

Right click to end copying from the current start point.

The Copy move command is still active.  Select the center of the circle 
as the start point for another copy.
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Click on the diagonally opposite corner of the square to create a copy 
there.

Right click to end the current copy.

Right click again to end the Copy move command.

Click Deselect All to leave the original circle unselected.

Rotate

Entities can be rotated about a selected center of rotation.  The axis 
of rotation can be parallel to the X, Y, or Z axis of the World or Plane 
coordinate system.

Select all the sides of the square.

Right click to end the selection.
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Click on the Rotate icon in the Transform menu.

To select the center of rotation, move the mouse pointer to the 
intersection of the X axis and Y axis.  Click when the square World 
origin indicator appears.

To create the rotated square as a copy of the 
original, enter 1 for the #Copies value in the 
Toolbox.

The toolbox now shows six options for the axis of rotation.  The 
default rotation mode is Rotation Z plane, which rotates entities in the 
current drawing plane.

You can enter the exact degrees of rotation in any of these fields, but 
for common rotation amounts a rotation protractor with markers at 
15° intervals is shown in the drawing window.
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Move the mouse pointer around the protractor, and click to rotate the 
square by 45°.
 

Right click twice to end the rotation command.

Click Deselect All to leave the original square unselected.

Setting Current Drawing Properties

OneCNC has a 2 color drawing system, controlled by color selection 
boxes in the Status Bar.

The color selector on the left is for geometry and that on the right is 
for surfaces and models.  To set the current color, click the selector 
and select the color you want to use.  To switch back to the default 
color just click the small square in the corner of the selector.

To select the line style and line thickness you would like all new 
entities to be drawn with, click the Styles icon.

OneCNC uses red to indicate an object is selected, so don’t use red 
for drawing. 
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Using Layers

Every entity created in OneCNC is said to be ‘on’ a Layer.  Layers give 
you control over entities on each layer as a group.  For example, if 
you draw dimensions on a layer named ‘Dimensions’, you can then 
turn off display of the layer to hide all dimensions while working on 
the drawing geometry.

Click on the Layer tab at the lower right of the screen to open the 
Layer Manager.

Up till now you have been working in a new file, on the default layer, 
Layer 1.  We will now create a new layer and move some of the 
geometry to the new layer.

To add a new layer, click on the + icon at the top of the Layer 
Manager.

The new layer is created with the default name Layer 2.  Click on the 
icon next to the + icon to rename the layer.



Page 64 Introduction to OneCNC Mill ©

Enter ‘Circles’ as the name for the new layer, and click OK.

The Layer list is sorted alphabetically, so the Circles layer is now 
above Layer 1.  It is highlighted in blue, indicating it is the active 
layer new entities will be created on, but the X in the visibility column 
shows it is an empty layer.

Select all the circles in your practice drawing.

Click on the Modify icon in the Status Bar.

Default Layers
You can set default layers  to be contained in each new drawing 
from the File menu > Properties dialog.  Select the Layers tab, click 
New, give the layer a name, and set a default color, line type, and 
width.



Page 65Introduction to OneCNC Mill ©

In the Modify Selected Attributes dialog, you can change the color, 
line type, thickness, or layer of entities.  Select the Circles layer in the 
Layer list to move the selected entities to that layer.

There is now a green eye icon in the Circles layer visibility column, 
indicating all entities on the layer are visible.  The red selection 
square indicates all entities on the layer are selected.  Click on the 
square to deselect the circles.

Click on the open eye icon for the Circles layer and it will close.
This will turn off display of all entities on the layer.
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Now you will be able to see the squares clearly.

Trimming Entities

Trim functions are used to shorten or extend existing entities.

Scissors
The quickest way to trim away unwanted parts of geometry is to use 
the Scissors tool.

Click on the Trim/Break icon in the Toolbox to open the Trim/Break 
menu.

Click on the Scissors icon to start the Scissors command.

Click on an unwanted part of a line or arc.
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The geometry will be trimmed back to the next intersection with 
another line or arc, and the command continues.  You can continue 
trimming by clicking on unwanted parts of geometry.  

Right click to end the command when you have finished trimming 
entities.

The Scissors command cuts entities back to the next intersection or 
endpoint in each direction from the point where you clicked on the 
entity.  If you click on an entity which is not crossed by another line 
or arc, it will be deleted.
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Trim Two

This function will shorten or extend two arcs or lines to their common 
intersection.  It is an important function as it can be used to make 
sure a chain of entities are properly connected at their endpoints.

Open a new file to practice using the Trim Two command.  Draw some 
lines that cross, and some unconnected lines.

Start the Trim Two command by clicking the Trim Two icon in the Trim 
menu of the Toolbox.

Click on the first line you want to trim, on the side of the intersection 
that you want to keep.
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Click on the second line you want to trim, on the side of the intersection 
that you want to keep.

The lines will be trimmed to their intersection.  In this example both 
lines were shortened.

The command continues, and you can click on the next line you want to 

trim.
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Click on the next line to trim.  In this example one line will be 
shortened and one will be extended to meet at their intersection.

Right click to end the command when you have finished 
trimming.  The four lines in this example have now been trimmed 
to form a closed boundary.

 

Click Select All and then click the Delete icon to clear the 
drawing area.

Some CAM operations require selection of consecutive entities as a 
profile chain.

Trim Two ensures that the junction between two entities is properly 
trimmed for chain selection, and can be used to repair a chain that 
will not select properly.



Page 71Introduction to OneCNC Mill ©

Chain Selection

Chain selection is an important function that selects consecutive 
entities to form a profile chain.  A profile chain can be open or closed.
For many CAM functions you will need to select a profile chain of 
consecutive entities as the first step of the toolpath definition.
  

To practice chain selection, draw a filleted rectangle.

Selecting a complete profile as a chain

Click on the Chain Selection icon to enter chain selection mode.

The mouse pointer changes to the word ‘start’.
Click on the entity that will be the first in the chain.
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Move the mouse pointer around till the red arrows are pointing in the  
direction that you want to chain select.  Click to set the direction.

The mouse pointer changes to the word ‘end’.  Click on the last entity 
of the chain you want to select, or press the F3 key to select all 
consecutive entities automatically.

The chain will be selected.  You can now start to select another chain, 
or right click to end chain selection.
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Selecting part of a profile as a chain

Click on the Deselect All icon to clear the previous selection.

Click on the Chain Selection icon to enter chain selection mode.

The mouse pointer changes to the word ‘start’.
Click on the entity that will be the first in the chain.

Move the mouse pointer around till the red arrows are pointing in the  
direction that you want to chain select.  Click to set the direction.
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The mouse pointer changes to the word ‘end’.  Click on an entity to 
end the chain.

The mouse pointer is still seeking a chain end.  You can click further 
along the chain to add one or more entities to the chain selection.

Right click when you are ready to finish selecting the chain.  You can 
now start to select another chain, or right click again to end chain 
selection.
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OneCNC CAD Tutorial 2
2D Drawing

This Tutorial is designed for all OneCNC products.

In this tutorial we will be using some of the time saving features of 
OneCNC CAD drawing to show how easily a part can be constructed.  
We will be drawing a part with fillets and chamfers, and a slot at an 
angle of 75 degrees.

Start a new file, and save it as ‘Cad Tutorial 2’.

Click on the View icon in the Status Bar to open the View menu, 
and select CAD View.

CAD view is a special top down view, specifically for 2D drawing in the 

XY plane.
While in CAD view all drawing is in World coordinates.
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Step 1: Draw outer profile

Click on the Rectangle icon in the Line menu to start the Rectangle 
command.
Enter 0 for Corner Radius, to draw the rectangle with sharp corners.  

Enter coordinates in the toolbox or use a grid snap to start the 
rectangle at X10 Y10.  You can then enter 150 for Length and 100 for 
Height to make the rectangle 150 wide in X and 100 high in Y.

To create the semi-circle on the right side of the part, start the Arc 

Sketch command on the Arc menu.

Click on the midpoint of the vertical line at the right side of the part to  

locate the center of the arc.
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The Arc Sketch function now requires the arc Radius, Start Angle, and  
End Angle.  Each of these can be defined by entering a value in the 
toolbox, or clicking on an entity or grid snap.

Enter 15 in the toolbox for the Radius of the 
arc.

Click on the endpoint above 
the arc center to set the 
Start Angle to 90°.

Click on the endpoint below 
the arc center to set the End 
Angle to 270°.
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Right click to end the Arc Sketch command.

To draw the angled line at the top left of the part, select the Line 
menu to start the Line command.

Click on the vertical line at the left of the part, between the midpoint 
and upper end.

To fix the start point of the line at 40mm from 
the end of the selected line, enter 40 as the 
Distance along value in the toolbox.
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Enter -60 for the Line Angle.

This will fix the angle of the new line at 60° 
from the direction of the anchor line.

Move the mouse pointer along the new line preview until it locks onto 
the horizontal line at the top of the part, and click to draw the line.

Right click to end the Line command.

We can now trim away the unwanted line segments.
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Start the Scissors command on the Trim/Break menu.

Click on the segment within the semicircle to remove it.

Click on the segments at the top left of the part to remove them.

Right click to end the Scissors command.

Next we will create the fillet on the lower left corner of the part.

Start the Fillet command on the Arc menu.
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Enter a Fillet Radius of 25 in the toolbox.

Click on the left side of the 
part near the lower left 
corner.

Click on the lower side of 
the part near the lower left 
corner.

The fillet is created, and 
the corner is trimmed 
automatically.

Right click to end the Fillet 
command.
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Next we will create the chamfer on the lower right corner of the part.

Start the Chamfer command on the Line menu.

Enter a Chamfer Distance of 15 in the toolbox.

Click on the lower side of 
the part near the lower right 
corner.

Click on the right side of the 
part near the lower right 
corner.

The chamfer is created, 
and the corner is trimmed 
automatically.

Right click to end the 
Chamfer command.
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Step 2: Draw the angled slot

The first step in construction of the slot will be to draw the centerline.

Select the Line menu to start the Line command.

Move the mouse pointer near the center of the fillet arc, and click to 
place the start point of the line there.

Type 25 in the Line Length box, and press 
Enter.

Type 45 in the Line Angle box and press Enter 
again.

The line will be drawn.

Right click to end the current Line sequence, and right click again to 
end the Line command.
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The part drawing should now look like this.

Start the Circle command to draw circles which will become the arcs 
at each end of the slot.

Type 10 in the Diameter entry box.

Click on the lower endpoint of the centerline to draw the first end arc 
of the slot.
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Type 20 in the Diameter entry box.

Click on the upper endpoint of the centerline to draw the second end 
arc of the slot.

Right click to end the Arc command.  You should now have two 
circles of unequal diameter, one at each end of the centerline. 
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Next we will join the circles with tangent lines.

Start the Line Tangent command in the Line menu of the Toolbox.

Draw the first tangent line by clicking near where the tangents will be.

Draw the second tangent line by clicking near where the tangents will 
be.

Right click to end the Line Tangent command 
and you will have two tangential lines as 
shown here.
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Begin the Single Selection command.

Select the 45 degree centerline.

Right click to end the selection process.

Click the Delete icon or press the Delete key to delete the 
centerline.

All we have to do now is trim the circles to 
the tangent lines to finish the slot.

Start the Scissors command on the Trim menu.
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Click on the unwanted segment of the lower circle to trim it away.
Circles have an endpoint at 0° so you must click twice to remove both 
ends of it.

Click on the unwanted segment of the upper circle to trim it away.
The remaining arc will be composed of two arcs because of the circle 
endpoint at 0°.  It is good practice to trim this to one arc.  Click below 
the 0° endpoint to remove the smaller arc.

Because the smaller arc is not crossed by 
any other entity, the Scissors command 
removes it completely. 

Right click to end the Scissors command.
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Start the Trim Two command.

Click on the tangent line to select it as 
the first entity to trim.  Click between the 
endpoint and the midpoint of the line.

Click on the arc to select it as the second 
entity to trim.

The two entities will now be joined perfectly.

Your drawing should now look like the picture at the beginning of this 
tutorial, which is now complete.  
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This tutorial is intended for Expert and Professional versions of OneCNC.

In this tutorial we will use OneCNC solid extrude commands to 
construct a 3D solid part.  You will need the outlines drawn in CAD 
Tutorial 2 before attempting this tutorial.  We will extrude the part 
with a taper angle and cut the through slot with vertical walls.

Step 1: Complete CAD Tutorial 2 and save a copy.

Complete ‘CAD Tutorial 2’ and save the file.  Use Save As on the File 
menu to save a copy as ‘CAD Tutorial 3’.  Press the Space bar and 
set the view to Trimetric.  Your part should appear as shown in this 
image.

OneCNC CAD Tutorial 3
Solid Modeling by Extrusion
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Step 2: Create a solid by extrusion from curves.

Click on the Extrude icon in the Toolbox to open the Extrude menu.

Click on the Extrude Curves icon.

Enter a Taper Angle of 15 in the parameters 
section of the Toolbox.  This will tilt the walls of 
the extrusion inwards.

Leave the Linear Corners check box 
unselected.

OneCNC now seeks a 
boundary to create an 
extrusion from.  Hover the 
mouse anywhere near the 
external boundary and click 
to select it as the outline of 
the part.  The entire outer 
boundary will be selected 
with one click.

You can extrude a shape 
with one or more openings, 
so the cursor will continue 
to seek boundaries.

Do not select the inner 
boundary.

Right click to end the selection stage of the command because in 
this case we want to create the slot using different settings.
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The height of the extrusion can be set by a mouse click or by entering  
the height in the toolbox. As you move the mouse, you will see a 
preview of the extrusion, and the current height will be displayed in 
the toolbox height entry.

Enter a Height of 10 in the parameters section 
of the Toolbox, and press the Enter key.

Click in the drawing window and the extruded solid is created with an 
external taper of 15 degrees.

Right click to end the command.
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Step 3: Create the slot with an extrude cut

The slot boundary we want to use is obscured by the solid we have 
made.  We could change the view direction but there is no need to do 
this, as we can change the model display setting to Transparent.  

Click on the Display icon to open the Display menu.

Select Transparent.  The slot geometry will now be visible 
through the part.

Click on the Extrude cut icon in the Extrude menu.

Change the Taper Angle to 0 so the slot will 
have vertical walls. 

Select the internal boundary to create the cut extrusion.
Only one boundary can be used for an Extrude cut so you do not have 
to right click to end the boundary selection.
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Because we want a through cut the exact extrusion distance is not 
important.  Move the mouse pointer up until the extrusion preview is 
above the part, and click to make the extrude cut. 

Right click to end the Extrude Cut command.

Click on the Display icon and change the display mode back to 
Normal.

To see how you can create a section view of your model, open the 
Section Tool topic in OneCNC Help.
You can find the topic in Help Contents -> CAD Drawing and 
Modeling -> Modeling Tools -> Section Tool.
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All new line and arc geometry, and surface and solid models, are 
created in the current construction coordinate system, which is 
independent of the world coordinate system.

When you open a new file in OneCNC, the current construction plane 
is the XY plane.  The X and Y axes of this plane coincide with the X 
and Y axes of the world coordinate system.

A transparent rectangle indicates the position and orientation of the 
XY plane of the current construction coordinate system.  The Origin 
selector at the right of the Status bar shows World coordinate input is 
active.

Clicking on the Origin selector will activate Plane coordinate input.
A plane origin indicator will appear.

OneCNC CAD Tutorial 4
Working With Planes
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As an introduction to Plane functions we will position a Plane as an aid 
to constructing a truncated wireframe pyramid.

Step 1: Draw a pyramid wireframe

Start a new file, and save it as ‘Cad Tutorial 4’.

Select World coordinate input, and use the Rectangle command to 
draw a square from X0 Y0 to X100 Y100.

Start the Line command, and click on the corner of the square to start 
the first edge of the pyramid.
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Enter World coordinates as shown to end 
the edge at the vertex of the pyramid.

Click on an adjacent corner of the square to finish the second edge of 
the pyramid.

Right click to end the current Line sequence, and construct the other 
two edges by clicking on corner, vertex, and corner.
Right click twice to end the Line command.
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Step 2: Position the plane

Open the Planes dialog by clicking on the Plane icon in the Status 
Bar.

In the Planes dialog you will see the XY 
Default Plane is selected in the Saved 
Planes list.

You will also see the pre-defined YZ and 
XZ planes.

The Display active plane check box must 
be selected for the plane to be visible.

Click on the Push or Pull Plane icon in the Planes dialog.

This command will move the current plane up or down along its Z 
axis.

Enter a drag amount of 50, and click OK.

The plane will be moved vertically by 50mm.
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Click on the Origin selector to activate plane coordinates.
The Plane origin indicator shows the origin of the moved 
plane.

We will now tilt the plane on its own Y axis to create the angle for 
truncation of the pyramid

Click on the Plane icon again to open the Planes dialog.

Click on the Rotate Plane icon.

The plane can be rotated around the World axes or its own axes.

To rotate the plane around its own Y axis, enter 15 in the Plane Y tilt 
entry box and click OK.
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The plane is tilted on its own Y axis.  The plane origin will still be 
directly above the World origin.

We will save this plane position so we can return to it easily.

Step 3: Save the plane position

Click on the Plane icon again to open the Planes dialog.

Click on the Save icon.

Name the plane Truncation plane and click OK.
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The plane now appears in the Saved 
Planes list.

Step 4: Create the truncated pyramid

To truncate the pyramid edges, open the Trim menu in the Toolbox, 
and click on the Trim to plane icon.  This command trims lines or arcs 
which pass through the plane to the plane intersection.

Click on an edge of the pyramid, between the base and the plane.

The edge will be cut off where it meets the plane.  Click on the next 
edge to trim it.
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The edge will be cut off where it meets the plane.  Click on the next 
edge to trim it.

Continue until all four lines are trimmed to the plane.

When you have trimmed all four side edges of the pyramid, use the 

Line command to join them.  These lines form the boundary of the 
truncation.
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Step 5: Return to default XY plane

To return to the XY plane, open the 
Planes dialog and select the XY plane in 
the Saved Planes List.

To return to World coordinate input, 
clear the Use plane coordinate system 
check box before clicking OK.

You will see the XY plane is 
current again.

You can return to the 
truncation plane by 
selecting it in the Saved 
Planes list.

To learn more about plane commands in OneCNC, go to ‘Construction 
Planes’ in the CAD section of OneCNC Help.
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This tutorial is intended for Expert versions of OneCNC, and Solid Creator.

Automated 3D model to 2D CAD drawing is a standard feature of 
OneCNC Solid Creator and OneCNC Expert versions, and can be added 
as an optional module to OneCNC Mill Professional.

Traditionally, a technical drawing was the first step in production of a 
part.  Now, you can design the part as a 3D model, and create one or 
more technical drawings automatically from the part.

The paperspace drawings are associated to the model, so if the design 
changes, you can change the part model and then update the drawing 
views automatically to show the revised part.

There are two stages to creating a technical drawing in OneCNC.
The first step is to create a drawing page layout with title block and 
border.  You can then create and manage views of your model in the 
layout.

OneCNC Technical Drawing
Automated 3D to 2D Drawing Layouts
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Add a drawing page with border and title block

To add a new page, click on the Pages icon in the Status Bar.

The Page Manager dialog will open.

Click on the Add page 
icon to open the Page 
Setup dialog.
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Templates are supplied for standard paper sizes with pre-drawn 
borders and title blocks. Select a template for the paper size you want 
from the Templates list, and enter a name for the page.

The Auto fill template section contains entries which can be 
automatically added to your title block. Fill these out as necessary, 
and click OK.

The new page now appears in the Pages list in the Page Manager.

The selected page will be seen in the main drawing window, with the 
title block showing the details input in the Page Setup dialog.  You can 
now place views from the Views list into the new page.

To return to the main drawing environment, select Model Space in the 
Pages dialog.
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Add views of the model to a drawing page layout

You can add a view of the model to an existing drawing page layout at 
any stage of the design process.

In the Pages list of the Page Manager, select the page layout you want 
to add the view to.

Select the view in the Views list, and a preview of the view will appear 
in the lower section of the Page Manager dialog.

Click the Place view on page icon to add the view to the page.
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The view will be attached to the cursor.  Click to place the view when 
it is in the position you want.

After placing the view, you are returned to the Pages Manager again, 
and you can continue placing views as necessary.

Views are not restricted to orthogonal representations. An Isometric 
view gives a good indication of what the part actually looks like.



Page 109Introduction to OneCNC Mill ©

You can create a section view in the Views list using a plane 
positioned where you want the section.

You can also use a plane to define a view from a specific direction.

Views and section views can be dimensioned as necessary to 
complete the drawing.

Using the 3D to 2D Technical Drawing module you can quickly create 
professional drawings to recognized standards.  For more detail on 
using the module see the Automated 3D to 2D drawing topic in the 
CAD section of OneCNC Help.
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This tutorial is intended for all levels of OneCNC Mill.

To make a part in OneCNC it is first drawn, modelled or imported.  
The required toolpaths are defined using the NC manager, and 
simulated to check them.  They are then output to an NC file, ready 
to send to the machine.

We will open a sample file which has machining already defined, and 
begin to define alternate machining in a new toolpath group.

Step 1: Open the sample file and save a copy.

Sample files are supplied with OneCNC which provide examples of 
parts and toolpaths.

Click on the Open icon at the top left of the OneCNC application 
window.

To open a OneCNC sample, go to the Samples folder, which is located 
in the Drawings folder where you installed OneCNC.

OneCNC Mill Tutorial 1
Creating a Facing toolpath
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Scroll down the list of files, select the file ‘spacer block.ONECNC’, and 
click Open.  Select Save As from the File menu, and save a copy of 
the file as Tutorial Mill 1.ONECNC.

Open the Plane dialog and turn off the display of the active plane. 
Press the Spacebar and select Trimetric from the View menu.  Turn off 
display of the Geometry layer.  Your view screen should now appear 
as shown.

We will now simulate the existing toolpath group so you can see how 
each toolpath contributes to the creation of the part.

The NC Manager tab is shown at the 
right of the drawing window.  Right click 
on the existing Toolpath Group #1, and 
select Simulate/Rest from the context 
menu.
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The Solid Verification dialog 
opens, so you can define 
stock size and other options.

In the Stock panel, choose 
the Extents option and 
make sure the Automatic 
Offset check box is not 
selected.

Set Start X and Start Y to 
-2.  Set End X to 155 and End Y to 105.  Set Z Top of Job to 0, and Z 
Bottom of Job to -38.1.

The Live Simulation window will open, and you can watch the 
toolpaths cutting away the material.  The current coordinates of the 
tool are displayed in the top right corner.
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The Live Simulation window has simple playback controls.

Go back to start of simulation.

Go back to the start of the previous tool.

Pause. This changes to Play when paused, which will resume the 
playback.

Enter simulation Step Mode.

Skip forward to the start of the next tool.

Go to end of simulation.

Turbo mode enables rapid simulation at lower resolution. 

You can adjust the playback speed of the simulation by dragging the 
indicator in the sliding speed control.

You can select a specific playback speed using the drop-down selector 
below the sliding speed control.
For example, if you select x2 the playback will be twice as fast. If you 
select /2 the playback will be at half the speed.

During simulation, the progress indicator in the progress bar 
moves from left to right.  The background color of the progress bar 
changes to match the current tool.  You can change the playback 
position by dragging the progress indicator in the progress bar.



Page 114 Introduction to OneCNC Mill ©

The toolbox on the left of the simulation window has view and display 
controls.  It also holds useful functions for checking your toolpaths.

The view tools allow you to change your 
viewpoint and zoom magnification. 

The Rest material functions are used to 
check for material which has not been 
removed yet.

The Display options can be used to show 
or hide the tool, holder, stock, backplot, 
and geometry.

If you are simulating a multi-axis 
toolpath you can also change the axis 
simulation mode.

During simulation you can check for 
rapid moves hitting the stock.  You can 
also check for collision between the 
shank or holder and the stock.

The Options icon re-opens the stock 
settings dialog.
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When the simulation ends the simulation window remains open.  
Close the simulation window when you are ready to return to 
OneCNC.

Step 2: Prepare for machining

Imagine you have been sent this part to make.  Before you begin to 
create toolpaths you need the answers to some basic questions.  How 
big is it?  How deep is the pocket?  What size are the bolt holes?  We 
will extract edges from the model to answer these questions.

Click on the Layer tab in the pane below 
the NC Manager.  The geometry used 
to create the block is on the Geometry 
layer, and the block is on the Model 
layer.

Click on the + icon to create a new 
layer, and name the new layer Extracted edges.  Select the Extracted 
edges layer as the active layer.

Click on the Model Tools icon in the Toolbox, and click on the Extract 
model edges icon in the Model Tools menu.
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Select the model to extract 
the edges from it.

Turn off the Model and 
Geometry layers and you 
will see the extracted 
edges.

Click on the Verify tab in the pane below the NC Manager.
Click on the Verify Single Entity icon in the Verify toolbar.

By clicking on various lines, and reading 
the sizes in the Verify panel, you will 
soon see we are dealing with a part 
designed in inch measurements.

This is not a problem, as OneCNC 
toolpaths are based on the existing 
geometry, we just need to find the 
depths to enter when we are creating 
the toolpaths.

The block is 38.1mm (1½”) thick and the pocket is 25.4mm 
(1”) deep.  The bolt holes have a diameter of 12.7mm, and the 
counterbores are 12.7mm deep.  Across the flats, the edge chamfers 
are 2.54 mm.

Right click when you are ready to end the Verify command.
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Click on the Display icon in the Status Bar to open the Display 
options dialog.

Select the No frame option, which will turn off display of 
surface edges.

Turn off the Extracted edges layer, and turn on the Geometry and 
Model layers.  You will see the basic outlines the part has been 
constructed from.  These outlines are in fact all the geometry we need 
now to create toolpaths for the complete job.

To make a new Toolpath group, right 
click in the NC manager panel and select 
New Group from the context menu.

Double click on the new group and 
rename it ‘Practice Toolpath Group’ 
in the Description box of the Process 
dialog.

Click OK to close the Process dialog.  
The new group will now be the active 
group new toolpaths are created in.
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Step 3: Facing toolpath

We will start this example by using a facing toolpath to clean the top 
of our stock to Z0.

To begin the facing toolpath wizard, click on the Stock Toolpaths icon 
in the Toolbox, and click on the Facing icon.

The cursor changes to the word bound, and the selection box will cling 
to the nearest geometry.  Hover the cursor near the outside boundary 
and click to select it.

The selected boundary will turn red and the cursor will cling to the 
next boundary it finds, as it is possible to face more than one region 
in the one operation.

As we are only facing the one part, right click to end the 
selection process.
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The Select Tool dialog appears, showing a preview of the last selected 
tool and holder.  If there was no holder associated with the tool, a 
generic holder with a blue taper will be shown.

We can now select the tool we want to use from the Tool Changer 
Library, the OneCNC tool management system in which you can store 
definitions for all the tools you use.

Click on the Tool Changer icon to open the Tool Changer.

At this stage we will only describe how to select a tool from the Tool 
Changer.  A detailed description of how to use the Tool Changer and 
manage tool definitions in the Tool Library system will be found in 
OneCNC Help > OneCNC Mill > Mill Common CAM settings.
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The Tool Changer dialog opens, with the Recent tab active.  
Tools you use regularly can be selected quickly from this tab.

To select a tool which is not shown in the Favourites list, click on the 
Library tab to see a categorized display listing all available tools.
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The Tool Library is composed of separate lists for each category of 
tool.  Each row in a list stores information for a single tool.
Click on the Facing tool icon at the left of the dialog, and the displayed 
list will change to show available Face Mill tools.

Select the 50mm Face Mill by clicking anywhere in the row for its 
listing, and click OK to return to the Select Tool dialog.
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The selected tool will be previewed in the Select Tool dialog, with its 
associated holder, which is defined in the Tool Library.  In this case the 
holder and tool have the same outer diameter.

Enter 6 for the tool number, which is the 
station on the machine the tool will be in.  Set 
Coolant to No 1 and Work Offset to G54, using 
the drop-down lists.

Leave the Spindle speed and feedrates as they 
are, as these will be calculated automatically 
when we select our material stock.
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The stock material is selected from the Material List,  which is 
accessed by clicking on the Stock Material name in the lower part of 
the Select Tool dialog.

The material definition contains cutting speed information for various 
types of tool, and this is combined with the tool data to calculate the 
feedrates and spindle speeds.

Select Aluminium Billet from the material list.

In the lower left corner of the dialog, ensure the check box for 
Calculate spindle and feed from material is checked.

Select the check box for Feed rounding, which will cut any decimal 
point value from the calculated feedrate, and click Accept to continue.

We will only describe how to select a material from the Material 
List at this stage.  A detailed description of the Material List and 
how to manage material definitions will be found in OneCNC Help > 
OneCNC Mill > Mill Common CAM settings.
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You will see the entry boxes for the Spindle Speed, Feedrate and 
Plunge Rate highlight in yellow as they are updated automatically.  

The Tool settings are now complete, and we are ready to proceed.
Click Next to continue defining the facing operation.

Plunge Rate by default is 50% of the Feedrate.  To change the 
percentage, type the percentage with the % symbol in the Plunge 
Rate box and that will be the new default.
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The Clearances dialog is for entering the Z values we want to use.

You will see the model with frames that indicate the current depth 
settings.

Start and Finish Clearance is shown as orange corners if enabled.  It 
provides extra clearance before and after an operation.  This is mainly 
used for multi-axis machining, while the part is repositioning.

Enter 5 for Rapid Z Plane.  The red frame shows the height the cutter 
will make positioning moves at.

Plunge Clearance is shown as black corners.  It is the incremental 
distance above the material top at which the plunge move changes 
from rapid to feed speed, and must be a positive value.  Set this to 1.

Enter 1 for Material Z top.  For a Facing operation this is the thickness 
of material to be removed above Z0.  Final Z is our Z reference for 
the job, so set this to 0.

Material Z Top and Final Z are the limits of the range that will be 
machined, and are both shown as blue frames.

Click Next when these settings have been made.

You will then see the Face dialog, which controls how the facing is 
carried out.
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Select the Zigzag strategy for Toolpath Type.

Approach distance is the lead-in distance as a percentage of the tool 
radius.  Set this to 110 so the plunge to the cut level occurs off the 
job.  Enter an Overlap amount of 50.  The tool will travel this far past 
the selected boundary on each linear pass.  Leave Toolpath Angle at 
0.  This setting can be used to change the angle of the facing passes 
relative to the X axis.

Select Auto stepover, enter 75 for the % of diameter value, and click 
Finished.

The new toolpath is created, 
and an instant preview will 
be displayed in the drawing 
window. 
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The Facing toolpath operation 
appears under the Practice Toolpath 
Group heading in the NC Manager.

When the operation is selected, 
you will also see a summary of the 
toolpath settings in the lower section 
of the NC manager.

Some of these settings can be edited 
directly from the NC manager, simply 
by clicking on the entry.  Click on 
the Rapid clearance and change the 
setting to 10.  Click on the tick icon 
to accept the new setting.

To simulate the new toolpath, right click on the operation in the NC 
manager, and select Simulate/Rest from the context menu.

In the NC Solid Verification 
dialog, set Z Top of Job to 
1, so you can see the stock 
being machined to the Z 
reference height.

Click OK to continue.
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The simulation appears, showing the stock being faced back to the Z0 
level.

Select the Show geometry icon in the toolbar at the left of the 
simulation window and the geometry outlines will appear.

Close the simulation window when you have observed the toolpath.

 In Mill Tutorial 2 we will complete the toolpaths for this part.

To see how the other facing strategies work, right click on the Facing 
operation in the NC manager list, and select Edit operation.  The 
toolpath wizard will re-open.  Click Next on the Tool and Clearances 
pages without changing any settings. 

When you get to the Face options dialog, select one of the other 
strategies and click Finished.  Simulate the operation again to see 
how the toolpath has changed.
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Stock toolpaths - Pocket, Profile and Chamfer

This tutorial is intended for all levels of OneCNC Mill.

This tutorial continues the toolpath group started in Mill Tutorial 1.  
Open the file you used for that tutorial, and save a copy of the file as 
Tutorial Mill 2.ONECNC.

Step 1: HS Pocketing toolpath

To begin the pocketing toolpath wizard, click on the Stock Toolpaths 
icon in the Toolbox, and click on the HS Pocketing icon.

The cursor changes to the word bound, and the selection box will cling 
to the nearest geometry.  Hover the cursor near the inside boundary 
and click to select it.  The selected boundary will be highlighted and 
the cursor will cling to the next boundary it finds, as it is possible to 
pocket more than one boundary in one operation.

We have only one pocket operation to do, so right click to end the 
selection process.

OneCNC Mill Tutorial 2
Stock Toolpaths
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When the Select Tool dialog appears, click on the Tool Changer icon to 
open the Tool Changer dialog.

In the Favourites list you will see the 20mm bullnose cutter which 
is already in use in this file.  Select it and click OK to return to the 
Select Tool dialog.

Enter Tool Number 1, set Coolant to No 1 and Work Offset to G54. 

Select Aluminium Billet from the Material List.

Select the Adjust high feedrate check box, and enter a value of 5000.
When the toolpath has to reposition inside the pocket, this will be 
done at the high feed rate without retracting if it is possible to do so.

Click Next to continue.
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The Clearances dialog for entering the Z values is similar to that used 
in the facing operation.

Clear the check box for Start and Finish Clearance, as we do not need 
it for this job.

Enter 5 for Rapid Z Plane.  This is the height the cutter will retract to 
between plunges during the operation.

Plunge Clearance is the distance at which the plunge changes from 
rapid to feed speed as it approaches the Material Z Top. Set this to 2.  

Material Z Top is our Z reference for the job, so set this to 0.

Set Final Z to -25.4, the depth of the pocket.

Click Next when these settings have been made.
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By clicking on the options in the Machining Style dialog, you will see a 
preview showing the types of toolpath they produce.

Traditional is the method which follows boundary offsets.  

Highspeed - Open is used when machining from an outside stock 
shape to an internal boundary.

For this part, select the Highspeed - Closed Toolpath option for the 
machining style, and click Next.
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The settings in the next dialog control the entry of the tool into the 
job.

Plunge entry is usually used for Highspeed Open toolpaths, as the tool 
can plunge down to Z level beside the part.  For a Highspeed Closed 
toolpath, helix entry is the preferred option.

Select Ramp Helix for the toolpath entry style, and enter a Ramp 
angle of 10 degrees.  Set the Helix Diameter at the maximum 20.

Select Automatic entry position, and click Next.
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In the Rough settings dialog, stepover is the width of the cutting path.  
Select Auto stepover and set it to 25% of the tool diameter.

When enabled, the Rough depths value is a positive number defining 
the depth increment for each roughing pass.  Clear the check box for 
Rough depths as the tool we are using can cut the pocket in one pass.  

Set Leave on sides to 0 as we are not doing a finish cut.  Set 
Tolerance to 0.005 and Wall taper to 0, and click Next to continue.

HSM Settings
The traditional pocketing method typically uses a stepover close to 
the tool diameter, with a rough depth equal to or less than the tool 
diameter.

The HSM toolpath was developed to use the flank of the tool to 
progressively side mill material from the remaining stock.  HSM 
machining can use depth of cut up to 2 x tool diameter if stepover 
is reduced to 30%.  This strategy is faster and needs less than 50% 
of the average power required for the traditional method.



Page 135Introduction to OneCNC Mill ©

It is possible to define Rough settings and Finish settings in one 
operation.  If you set a Leave on sides amount in the Rough settings, 
you can define Finish pass settings in the Finish Settings dialog.

We will use Finishing in the next toolpath, but for this operation leave 
Finishing set to None.  Click Finished to create the toolpath.

Click on the new toolpath in the NC manager, and you will see a 
preview of the toolpath in the drawing window.
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Step 2: Mill Profile toolpath

To cut the outside of our part, we will create a Mill profile toolpath.

Click on the Stock Toolpaths icon in the Toolbox, and click on the Mill 
profile icon.

Click on the outside 
boundary to select the start 
of the chain.

Four side and direction 
indicator arrows will appear.  

The arrow closest to the 
cursor will be highlighted 
red, indicating the current 
side and direction for the 
toolpath.  Hold the cursor 
so that the arrow outside 
the boundary and pointing 
to the left is red, and click 
to confirm the side and 
direction.

Select the last entity in the 
profile to cut, or press F3 to 
automatically select to the 
end of the chain.

Right click to end the 
selection process.
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Click on the Tool Changer icon and select the 25 MM HSS END MILL 
tool.

Enter Tool Number 2, set Coolant to No 1 and Work Offset to G54. 

Select Aluminium Billet from the Material List, to update the Feed and 
Speed settings.

Click Next to continue.
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In the Clearances dialog, we need to enter the Z depth values for this 
operation.

Enter a Rapid Z Plane clearance of 5, with a Plunge clearance of 1.  

Set Material Z Top to 0.

The block is 38.1 mm deep.  Enter a Final Z of -38.3, so the cutter 
goes a little below the edge of the block.

Click Next to continue.
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The Path Creation dialog gives you the option of machining the profile 
by horizontal levels or as a continuously descending ramp.

Select the Cut Levels option and click Next to proceed to the Roughing 
settings.
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In the Rough settings dialog, select Auto stepover and set it to 75% 
of the tool diameter.

Select the Rough depths checkbox, and enter a value of 19.5.

Enter 0.2 in the Leave on sides box, this is the amount the rough pass 
will leave for finishing.

Clear the check box for Remove amount, as we do not need to 
remove extra material with horizontal offsets.

The sides are vertical so set Wall taper at 0.

Clear the check box for Last cut.  This can be used to specify a 
specific increment for the last cut when breaking through material.

Click on Next when you are ready to continue.
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When the Finish settings appear, select Bottom only from the drop-
down list for finishing, so there will be a finish pass after the last 
roughing pass is complete.

Select Automatic from the dropdown list for the cutter radius 
compensation method.  OneCNC will write the NC file with the 
appropriate offset for the selected tool.  If you want to use G41 or 
G42 on your machine, you would select the “at Control” option.

The rough settings we defined will have the cutter make a roughing 
pass at Z-19.5 and then at full depth, with 0.2 offset each time.

The Bottom only Finish setting means there will then be a finish pass 
on the geometry at full depth.

Click Next to continue.
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In the Entry / Exit dialog, we will enter the variables which control 
leadin and leadout.

Use the drop down selectors to set Leadin and Leadout style to Line-
Arc.

Enter a Leadin Radius of 5, and Leadin Angle of 135.

Enter a Start Line Length of 5, and a Start Line Angle of 0.

Click on the arrow button above the Exit values to copy the Entry 
values to the Exit values.

Click Finished and the Mill Profile toolpath will be created.
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Simulate the new toolpath and you will see the cutter roughing and 
finishing the profile.  When the cutter finishes the first roughing 
pass it will feed down and cut the second roughing pass.  It will then 
retract before repositioning to begin the finish pass.

Close the simulation and we will continue with the Chamfering.

Leadin/Leadout

The leadin-leadout settings used create a teardrop shaped toolpath 
which starts and stops at the same point for the rough passes.

This means the cutter is allowed to plunge to the second rough 
depth without retracting to the rapid plane.

The toolpath will retract to the rapid plane when the cutter has to 
reposition to start the finish pass.  

For safety, OneCNC always retracts the tool before repositioning.
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Step 3: Chamfer toolpath

We will now use a Chamfer toolpath to chamfer the pocket and 
outside edges in one operation.  The chamfers on the boltholes will be 
created as part of the hole feature operation in the next tutorial.

Click on the Stock Toolpaths icon in the toolbox, and then select 
Chamfer edge from the Stock Toolpaths menu.

Select the outside profile as before.  Set the direction as shown and 
press F3 to automatically select the complete profile.

Click on a start position for the internal profile, and click as shown 
to set the side and direction.  Press F3 to automatically select the 
complete profile.

When both profiles have been selected, right click to end the 
selection process.
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Select the 12mm chamfer tool from the Tool Library.

Enter Tool Number 3, set Coolant to No 1 and Work Offset to G54.  

Select Aluminium Billet from the Material List, to update the Feed and 
Speed settings.

Click Next to continue.
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In the Clearances dialog, the only entries required are those for Rapid 
Z Plane, which we will set to 5, and Plunge clearance, which we will 
set to 1.

The Z depth of the chamfer cut is not required in the Clearances 
dialog, as this will be calculated automatically in the next step of the 
toolpath definition.

The depth is determined relative to the selected geometry.

Chamfer Depth

If the geometry you want to use is not at the required Z level, you 
can use the Z Position option of the Smart Projection command in 
the Model menu to move or copy it.
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Our outline is at the intersection of the top surface and side of the 
part, which is marked by the number 1 in the diagram, so we will 
select 1. Normal for Geometry Position.

Select the check box to set Tip Z to auto.  This modifies the cutter 
travel so the cutter flute is centered on the chamfer flat, with the tip 
below and outside the profile.

The Length and Width boxes refer to the length across the chamfer 
surface, and the horizontal width of the chamfer.
 
On our model, the edge chamfers are 2.54 mm (0.1”) across the 
chamfer, so enter 2.54 in the Length box.  The Width box will update 
to 1.796, the horizontal width of the chamfer.

The Length and Width boxes are linked, and each can update the 
other.  If you enter the horizontal width of the chamfer in the Width 
box, you will see the length across the chamfer calculated.
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The Entry / Exit conditions can be set exactly as used for the Mill 
Profile toolpath.

Click Finished, and the Chamfer toolpath will be created.
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This tutorial is intended for all levels of OneCNC Mill.

In this tutorial we will complete the toolpath group started in Mill 
Tutorials 1 & 2.  Open the file you used for Mill Tutorial 2, and save a 
copy of the file as Tutorial Mill 3.ONECNC.

Step 1: Hole Feature selection

Hole Feature Recognition is a time saving method of creating all the 
drilling and machining commands for a set of holes in one operation.  

Click on the Stock Toolpaths icon in the toolbox, and then select Drill 
Hole Wizard from the Stock Toolpaths menu.

The Hole Wizard will open 
with a window containing 
a browser list of all the 
hole features found in the 
current window.

Select the check box for the 
simple hole group and the 
four holes in the group will 
be selected automatically.

OneCNC Mill Tutorial 3
Hole Feature Recognition
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When you have selected the holes, click Next to proceed to the 
Clearances dialog.  Set the Rapid Z Plane at 5, Plunge Clearance to 1 
and Material Top to 0.  Click Next to continue.
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On the left of the Settings dialog is the Hole Operations list, where 
you can define multiple operations to apply to the selected holes.

The list of operations can be saved as a Hole Definition.



Page 152 Introduction to OneCNC Mill ©

Step 2:  Drill Operation

Click on the Drill icon and a new drill operation will be added to the 
Hole Operations list.
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Right click on the operation and choose Edit ‘Drill’ from the context 
menu.



Page 154 Introduction to OneCNC Mill ©

Each Hole operation is defined in a step by step fashion similar to the 
Stock toolpaths dealt with earlier.

The first step in defining the Drill operation is to select the 12mm Drill 
from the Tool Library.

Enter Tool number 4, and set Coolant to No1 and Work Offset to G54.

Select Aluminium Billet from the Material List to set the feedrates and 
spindle speed.

Click Next to continue.
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In the cut Parameters dialog there are a number of methods available 
to create the hole.  Select Automatic drilling, which is the setting for 
OneCNC to create the drilling cycle.

Set Depth Style as Absolute, and enter -38.2 for Final Z, a little below 
the bottom of the part.  The tool depth is measured at the point of the 
drill, so this setting alone would not drill the hole completely.

Select the Drill Through check box, which enables compensation for 
the point angle.  The depth value will now be -42.015, which will put 
the edge of the drill past the base of the hole.

Hole Feature Operation Settings
OneCNC can create circular holes by plunge drilling or machining.
To learn more about hole feature methods, see the Hole Feature 
Settings topic in the Mill Hole Features and Drilling section of the 
OneCNC Help files.
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When Automatic Drilling is selected, you will see the Custom Drilling 
dialog when you click Next.

This has options for choosing drilling type and the relevant settings 
for each type.  Select Peck drilling, and set Dwell to 0.

Set Max Peck Amount to 2.  OneCNC will calculate the nearest peck 
distance to drill the hole in regular intervals.

To enable rapid instead of feed moves when returning to depth after 
each retract, select the check box for Rapid Return Clearance and 
enter a value of 0.5 to change the rapid return to a plunge feed move 
0.5 from the new cut level.

Select Rapid Retract Speed, and Retract to Rapid Plane.

Click Finished to return to the Hole Feature Settings dialog.



Page 157Introduction to OneCNC Mill ©

Now that the Drill operation is defined, a cross section appears in the 
preview pane.  Next we will add a Counter Bore operation.
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Step 3:  Counter Bore Operation

Click on the Counterbore icon to add the next operation to the Hole 
Operations list.

Right click on the new Counterbore operation and select Edit ‘Counter 
Bore’.



Page 159Introduction to OneCNC Mill ©

Counter boring is a machining operation, so we need to select a 
milling cutter.

Select the 8mm carbide end mill from the Tool Library.

Enter Tool number 5, and set Coolant to No1 and Work Offset to G54.

Select Aluminium Billet from the Material List, and click Next to 
continue.
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Select the Helix Hole Style option, which creates the hole by 
machining down a helical ramp.

Enter 20 in the Diameter box.  The diameter of Profile, Helix, and 
Clean Circle hole features is not determined by the circles selected for 
center positions, they will be cut to the diameter entered here.

Select Incremental Depth Style and enter a value of 12.5, which is 
the distance from the selected geometry to the bottom of the counter 
bore, then click Next.
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The entries in the Settings dialog determine how the helical machining 
will be carried out.

For this operation, enter 0 for the Leave for finish value, as we will not 
be doing a finish pass.

Enter a value of 2 for the Depth per turn.  This setting is the pitch of 
the helical ramp, so the cutter will descend at 2mm per revolution.

Select the Climb milling option for the Direction of Cut.

Click Finished and the Counter Bore operation will be complete.



Page 162 Introduction to OneCNC Mill ©

The Counter Bore operation now appears in the preview pane.

Operations selected in the Hole Operations list are shown in light blue.
To complete the hole operations, we will chamfer the hole edge.
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Step 4:  Chamfer Operation

Click on the Chamfer icon to add a Chamfer operation to the Hole 
Operations list.

Double click on the Chamfer operation to open it for editing.
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Select the 12mm Chamfer tool you used earlier from the Tool Changer 
Favourites list.

Set Coolant to No1 and Work Offset to G54.

Select Aluminium Billet from the Material List, and click Next to 
continue.
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There are three settings in the Cut Parameters dialog for a Chamfer 
operation.

For this job, set the Diameter to 20.  Like the Helix operation, the 
diameter of the inner chamfer edge is not constrained by the size of 
the circle selected for its center.  The Chamfer will be cut to the size 
entered, so we must be careful to enter the same value.

Enter a Tip Offset of 1 and set the chamfer Width to 1.5.

Click Next to continue.
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In the Path Creation dialog, select Plunge entry and Climb Milling.
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In the Settings dialog, set Leave for finish to 0, and click Finished.
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The Chamfer operation is now complete, and the complete hole profile 
is shown in the preview pane.

Before clicking Finished to create the hole feature toolpaths, we will 
save the Hole Operations list for future use as a Hole Definition.  Once 
saved, drilling and machining for a particular bolt or hole size can be 
quickly applied in a new part. 
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Step 5:  Saving Hole Operation Settings

Right click in the Hole Operations pane and select Save List from the 
context menu.

Enter a name for the Hole Definition that you will recognise easily 
when you need it again, and click OK.
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Click Finished to create the toolpaths.

For a fixed display of the toolpath, right click on the Hole operation in 
the NC manager, and select Backplot from the context menu.

The toolpaths for the hole operations are drawn as geometry in the 
drawing window, on a new layer named Backplot.
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This tutorial is intended for all levels of OneCNC Mill.

This tutorial will cover toolpath management and NC file output 
features of the NC Manager, using the toolpaths from your Tutorial Mill 
3.ONECNC file.  Open the Tutorial Mill 3.ONECNC file and save a copy 
as Tutorial Mill 4.ONECNC.

NC Manager Groups and Operations 

When you create a toolpath in OneCNC, it is created in the active 
Toolpath Group, which is highlighted in the NC manager.

By right clicking an operation or group 
you can use the NC Manager context 
menu to select various functions.
The toolpath order can be changed by 
dragging toolpaths into new positions.

When a toolpath is selected, it will be 
previewed in the drawing window, and 
the current settings will be displayed 
in the settings pane below the toolpath 
pane.

Many toolpath settings can be changed 
directly in the settings pane.

OneCNC Mill Tutorial 4
The NC Manager and Outputting NC files
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Duplicate an operation

In the Practice toolpath group 
the 12mm chamfer tool is used 
twice.  Because the chamfer is the 
last operation in the Hole Feature 
definition, we can eliminate the 
need for a tool change by putting 
the Hole Feature before the Chamfer 
operation.

Before making any changes we will 
make a copy of the Practice group.  
Right click on the Practice Toolpath 
Group name bar, and select Duplicate 
Group from the context menu.

A duplicate Toolpath Group is created 
beneath the Practice group.  The 
Practice Toolpath Group is still the 
active group.

Click on the - symbol at the left 
of the Practice Toolpath Group to 
contract it.

Click on the + symbol at the left of 
the new group to expand it.  
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Right click on the Duplicate group 
name bar, and select Activate Group 
from the context menu.

The duplicate group name bar will be 
highlighted, indicating it is now the 
active group.

To move an operation

Select the Hole Feature operation and 
move it up by holding the left mouse 
button down on the operation name 
and dragging it to its new position, 
above the Chamfer operation.

Simulate the duplicate group and you will see all the chamfering now 
happens at the end of the program.
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The NC Processing dialog

Select the Duplicate of Practice Toolpath group, and click on the 
Process icon at the top of the NC Manager.  This opens the Process 
dialog which has controls and tools for Post-processing your program.

The left side of the Process dialog has icons for many of the functions 
which appear in the NC Manager right click context menu.

The text fields in the Process dialog allow input of information that 
can be included in the NC program.

A toolpath or group can be turned on or off for simulation and output 
using the Status selector.

Change the Description to Edited Toolpath Group.

When we moved the hole feature operation, the operation numbers 
were no longer in sequence.  Click Renumber operations to renumber 
the operations in the group.
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NC Code output

OneCNC formats the NC file as it is output, to suit the varying 
requirements of different makes of CNC machines.

The format setting is called a ‘Post’, which is short for post-processor.  
OneCNC is supplied with a comprehensive set of prepared Posts for 
most machines in use.

Click on the drop down list to select the Post for your machine. 

Click on the Post icon to output the NC program.

The Save As dialog appears.  Choose the directory to save the file to, 
and enter a name for the file.  Select the file type from the Save As 
type: list and click Save.

A Post can be customized by clicking on Setup to open the NC Post 
Settings dialog.

See the ‘Mill NC Post and DNC Settings’ in the OneCNC Mill CAM 
folder in the Help files for guidance on this advanced subject.
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Your NC file opens in OneCNC Link,  which is an independent text 
editor and RS232 communications program.

When you first start using OneCNC you should check through the 
output to make sure it is formatted the way you want for your 
machine.  You will post and send files with confidence once your 
format is proven.

To send the file to your machine, click on the Send icon on the 
OneCNC Link Standard toolbar to open the communication dialog for 
your machine.

Comprehensive information on how to use the OneCNC Link NC 
Editor, and setup communications, is available in the OneCNC Link 
Help files.  The editor includes the standard text editing tools such 
as Find and Replace, and has a convenient machining calculator for 
feed and speeds.

As well as sending files to your machine, OneCNC Link can be used 
to type parametric programs or receive and archive programs which 
may have been edited at the machine controller.
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Post Settings:  Start And Finish Format

An NC program will start with initial information such as a program 
number, default G and M codes, and text comments in ( ) brackets 
for the operator.  This section is defined by the Start lines of the Start 
and Finish Format. 

The output from each toolpath operation will consist of code lines for 
a toolchange defined by the Tool Format Start Lines, and then the 
movement of the tool defined by the line and arc movement formats. 
The operation will end with the Tool Format End Lines.

Toolchanges and operations continue as required.  After these 
instructions, there will be an end of program section with return to 
home position and program end codes.  This section is defined by the 
End lines of the Start and Finish Format.

%
O0001
N10 (PART - 001)
N20 (FILE - D:\ONECNC\MILL 4.ONECNC)
N30 (AUTHOR - DEFAULT USER)
N40 (GROUP - SPACER BLOCK)
N50 G00 G40 G49 G80
N60 G00 G90 G54

N18920 G91 G28 Z0.
N18930 G91 G28 X0. Y0. M05
N18940 M30
%

N30 G00 G17 G40 G49 G80 G90
N40 (50 MM CARBIDE FACE MILL)
N50 T6 M06
N60 G00 G90 G54 X-24.764 Y3.325
N70 S0 M03
N80 G43 H6 Z10.
N90 M08
N100 G00 X-24.764 Y3.325 Z10.
N110 Z1.
N120 G01 Z0. F0.0
N130 X-8.302
N140 X164.9
N150 Y34.975
N160 X-12.5
N170 Y66.625
N180 X164.9
N190 Y98.275
N200 X-8.302
N210 G00 Z10.
N220 M09
N230 (END TOOL)
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Post settings are managed in OneCNC by the NC Post Settings dialog, 
which has powerful but easy to use commands for changing  how your 
file is output.

It is important that you understand the NC code for your machine 
before making changes to an existing post.  If you don’t know what 
effect changing a format setting will have, leave it alone as incorrect 
settings may cause serious damage.  For now we will only explain how 
to add a tool list to the Start lines of the Start and Finish Format.

To create a copy of an existing post and edit it, click on the Setup icon 
at the right of the Post selector.

The NC Post Settings dialog will open.  Click on the New Post icon at 
the top of the dialog.  Enter a name for your new Post and click OK.  
The new Post will be a copy of the Post that was active when you 
clicked the New Post icon.

Select the Posting Format tab.

It is recommended that you always create a copy before editing 
a Post.  Editing the new Post will not affect the Post it was copied 
from.  You will have the original Post to refer to if you want to check 
settings you have changed, and you can revert to the original Post if 
necessary.

All users must be informed of changes made to a Post.
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Select START and FINISH FORMAT from the drop down format list.
In the Start Lines - box, you will see lines of text.  This is the format 
for the beginning of every NC program using this Post.

Each block of text in { } brackets represents a variable which will be 
output in the NC file as the variable value.  Text not in { } brackets 
will be output as is.

On the right side of the Posting Format 
Tab is a list of the available Substitution 
variables.  Select the Tooling variable.
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Click to place the cursor as shown in the 
Start Lines text box.  Click the Insert button 
to add the Tooling variable to your post 
format.

The {TOOL_SUMMARY} Tooling variable 
appears at the cursor position.

Click OK to accept the changes and close the NC Post Settings dialog.

Select the modified Post in the NC Processing dialog, and click on the 
Post icon to output the NC file.

Specify the file location to save to, and the file will open in NC Link.
The {TOOL_SUMMARY} Tooling variable has inserted a list which 
shows the operator what tools are used and the station they are in.

The {TOOL SUMMARY} writes its own ( ) brackets in the output file, 
but other variables used in comments must be inside a pair of ( ) 
brackets in the Post format.
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This tutorial is intended for all levels of OneCNC Mill.

This tutorial covers the use of the Cut Chain 2D, Cut Chain 3D, 
Engrave All 2D, and Engrave All 3D toolpaths.  These are all toolpaths 
which follow the defining geometry without an offset.

Cut Chain 2D

This toolpath is used to cut a single entity or chain of entities.  The 
toolpath will ignore the Z-values of the geometry.  The tool center will 
travel along the chain at the Z depth specified.  One of the uses for 
Cut Chain is to create a slot, when you know where the centerline will 
be.

Save a new file as Tutorial Mill 5, and create a layer named Chain 2D.

Draw a rectangle 100 x 75 with a corner radius of 10, starting at X10 
Y10.

Click on the Stock toolpaths icon, and select the Cut Chain 2D 
toolpath.

OneCNC Mill Tutorial 5
Stock toolpaths - Cut Chain and Engrave All 
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Click on the chain where you want the cut to start.  Click as shown to 
set the direction of travel, it doesn’t matter which side of the chain 
you select as the toolpath is not offset.

Press F3 to select the rest of the chain automatically.

Select the 4mm carbide end mill tool from the Tool Library, and enter 
Tool No. 1.  Set Coolant to No1 and Work Offset to G54.
Select Aluminium Billet from the Material List, and click Next to 
continue.
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In the Clearances dialog, set Rapid Z Plane at 5 and Plunge Clearance 
to 1.

Set Material top to 0 and Final Z at -4.

Click Next to continue.
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The Path Creation settings allows you to mill to the full depth in 
more than one pass.  Select the Cut Levels Toolpath style, and enter 
a Depth of cut value of 2.  The toolpath will be cut in 2mm deep 
increments.

Click Finished to create the toolpath.  The toolpath appears as a Cut 
Chain 2d operation in the NC Manager, and will preview in the drawing 
window when the operation is selected.
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Cut Chain 3D

This toolpath is used to cut a single entity or a single chain of entities. 
It is similar to Cut Chain 2D, but as well as following the XY values, 
the toolpath will follow the Z-values of the chain geometry itself.

We will demonstrate Cut Chain 3D on a copy of the Chain 2D 
geometry, rotated into a 3D position.

Select the slot geometry on the Chain 
2D layer by clicking the selection box 
in the Layers Manager.

Select the Rotate command from the Transform menu.

Select the World origin as the point to rotate around.

Select Copies and enter 1.

Select the Attributes check box to enter 
the new layer for the rotated copy.
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Enter Chain 3D in the Layer entry box.
The layer will be created for the rotated copy.

Enter 15 for the angle of rotation in the 
Rotation Y entry box, and press Enter.

This will rotate the selected geometry 
about the World Y axis. 

Right click to end the Rotate command.

Turn off display of the Chain 2D layer, 
and select Chain 3D as the current layer.
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The display of the original chain has now been turned off, and the 
rotated copy is still visible on the new layer.

Click on the Stock Toolpaths icon and select the Cut Chain 3D 
toolpath.

Pick the start point near the top of the chain, and click to set the 
direction of cut.  It doesn’t matter which side of the chain you are on 
as the center of the tool will travel on the geometry path.

Press F3 to select the rest of the chain automatically.
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The Select Tool dialog will appear.

Using the Tool Changer, select the 4mm carbide end mill used for the 
Cut Chain 2D toolpath.

Set Coolant to No1 and Work Offset to G54.

Select Aluminium Billet from the Material List, and click Next to 
continue.
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In the Clearances dialog, set Rapid Z Plane at 5 and Plunge Clearance 
to 1.

Set Material top to 0.

There is no Final Z entry as the depth is set by the geometry.

Click Next to continue.
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The Path Creation settings allows you to mill to the full depth in more 
than one pass, but for this example select None for the Toolpath style. 

Click Finished to create the toolpath.  The toolpath appears as a 
Cut Chain 3D operation in the NC Manager, and will preview in the 
drawing window when the operation is selected.
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Engrave All 2D

The Engrave All 2D function is used to automatically cut all entities 
visible in the view port at a set Z level

Open the sample file ‘Engrave All Variable Z.ONECNC’.  
Save a copy of the file as ‘Tutorial Mill 5 Engrave All.ONECNC’.

Turn on the 2D Engraving layer, and 
turn the other layers off.

You will see the 2D engraving geometry.

Click on the Stock Toolpaths icon and select the Engrave All 2D 
toolpath.
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As all visible geometry is automatically selected for this toolpath, you 
will see the Select Tool dialog immediately.

Select the 6mm 60 degree engraver tool from the Tool Library, and 
set Coolant to No1 and Work Offset to G54.

Select Aluminium Billet from the Material List, and click Next to 
continue.
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In the Clearances dialog, set Rapid Z Plane at 5 and Plunge Clearance 
to 1.  Set Material top to 0 and Final Z at -1.  Click Next to continue.

An engraving tip

For small text, a single line shx font such as _romans will be clearer 
and take less time to cut.

When engraving larger text, a bold TrueType font will give a better 
result as the separation of the outlines is more distinct.  
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The Path Creation settings allows you to mill to the full depth in more 
than one pass, but for this example select None for the Toolpath style. 

Click Finished to create the toolpath.  The toolpath appears as a Cut 
All 2D operation in the NC Manager, and will preview in the drawing 
window when the operation is selected.
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Engrave All 3D

Like Engrave All 2D, this function is used to automatically cut all 
entities visible in the view port.  Instead of cutting at a set Z level, 
the Variable Z toolpath will follow the Z-values of the geometry itself.
It is often used to engrave text which has been created on, or 
projected onto, a 3D surface or plane.

Turn on the 3D Engraving layer, and 
turn the other layers off.

You will see the 3D engraving geometry.

Click on the Stock Toolpaths icon and select the Engrave All 3D 
toolpath.
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As all visible geometry is automatically selected for this toolpath, you 
will see the Select Tool dialog immediately.

Select the 6mm 60 degree engraver tool from the Tool Library, and 
set Coolant to No1 and Work Offset to G54.

Select Aluminium Billet from the Material List, and click Next to 
continue.
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In the Clearances dialog, set Rapid Z Plane at 5 and Plunge Clearance 
to 1.

Set Material top to 0.

There is no Final Z entry as the depth is set by the geometry.

Click Next to continue.
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The Path Creation settings allows you to mill to the full depth in more 
than one pass, but for this example select None for the Toolpath style. 

Click Finished to create the toolpath.  The toolpath appears as a 
Cut Chain 3D operation in the NC Manager, and will preview in the 
drawing window when the operation is selected.



Page 199Introduction to OneCNC Mill ©

Advanced Stock Toolpaths

Thread Milling

Thread Milling is an efficient means of cutting a thread, especially for 
larger diameters.  With a single tip the toolpath follows a helical path 
corresponding to the pitch of the thread.

Corner Rounding

The Corner Rounding toolpath is specifically designed for the 
application of corner rounding tools to an edge of a part. It is applied 
to a selected chain, and is similar to the chamfer operation as the Z 
level of the toolpath is set relative to the selected geometry chain.

Clean Circle
This function creates a pocketing toolpath optimized for circular 
geometry boundaries.

The method of defining these Stock Toolpaths is very similar to the 
toolpaths we have already covered.  For detailed instructions see the 
relevant topics in the Mill Stock Toolpaths section of OneCNC Help.
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This tutorial is intended for all levels of OneCNC Mill.

For each toolpath strategy other than Hole Feature Recognition, 
OneCNC saves the settings you use so you can refer to them later and 
re-use them easily.  Hole Feature Recognition saves its own templates 
separately as Hole Definitions.  Template settings are available in any 
part you are working on, so you can confidently apply tested settings 
to new parts.

Each time you start OneCNC, you are given the opportunity to open 
with a custom user profile, by clicking the arrow beside the user name 
in the lower left corner of the startup screen.  If you do not save a 
custom name, settings will be applied to the Default User profile.

As well as saving OneCNC customization settings, your user profile 
also saves your own CAM templates automatically.  You can save 
a template you want to use often as a favorite, giving it a more 
descriptive name so you can find the template you want to use easily.

OneCNC Mill Tutorial 6
Toolpath Templates
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As you create toolpaths, the settings you 
use are listed in the history section of the 
Templates panel, on the left of the toolpath 
dialog pages.

When you are defining a toolpath, double-
clicking on a template will reload the settings 
that were used for that toolpath in all the 
toolpath wizard dialogs.

As an example, we will start by saving a template for a pocket 
toolpath.  In Mill Tutorial 2, we created a HS Pocketing operation.  To 
access the settings for the pocket toolpath, open the file containing 
the operation.

Right click on the Mill Pocketing 
operation, and select Edit Operation 
from the context menu.

Before saving a template as a favorite, you should step through the 
toolpath wizard, checking the tool and settings used as you go, until 
you reach the last dialog in the wizard.

When you reach the end of the toolpath 
wizard, right click in the templates area 
at the left of the screen, and select Save 
settings from the context menu.
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The Save Template dialog opens.

Type a name for your operation in the 
entry box at the top of the dialog.

This operation has been named ‘20 BN 
Z-25.4 Aluminium’

Once saved, the template appears in the 
favorites list of the Templates panel.

To guard against accidental editing, you can 
lock the template by clicking on the padlock 
icon next to the star.

To re-use a template, all you need to do is start the toolpath, and 
double-click the template name you want to use.

To see this in action, open your Tutorial Mill 5 file and turn on the 
Chain 2D layer.  Click on the Stock Toolpaths icon and select the HS 
Pocketing toolpath.

Select the boundary and right click to end the selection process.
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Double-click on the template you just saved and all the dialogs of the 
toolpath wizard will be pre-loaded with the template settings.  Step 
through the dialogs of the wizard without changing any settings, and 
click Finished.

You will see the saved pocketing toolpath settings applied to the new 
rectangle.
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It is important to understand that a template is simply a method of 
pre-filling the wizard settings, which can still be changed after the 
template has been selected.

One time-saving way to build your template set is to use an existing 
template as a basis for a new one.  Right click on your new pocketing 
operation, and select Duplicate operation from the context menu.

Double click on the duplicate operation, and rename it Mill Pocketing 
Steel in the NC Processing dialog.  Click on the Edit Operation icon to 
change the settings in the duplicate operation.

When the Select Tool dialog appears, double 
click on the template to make sure it is 
loaded.  Change the Stock Material to Steel 
Free Machining.

Click Next and proceed to the last dialog of the toolpath wizard.

Right click in the Templates area, and select 
Save settings.
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Enter the new name, 20 BN Z-25.4 
Steel, and lock the new template.

The original template will be unaffected.

You now have two pocketing templates which can be applied quickly 
and easily.

You can use settings saved for a tool from the history and change the 
settings on the way through.

For example, if you have a 10mm end mill and as a result of 
sharpening it is now 9.7mm, you can load a 10mm favorite, then 
change the size to 9.7.  As you step through the toolpath wizard, 
settings such as stepover will be recalculated automatically.

If you do not save the settings, your templates will not be affected.
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This tutorial is intended for OneCNC:	 Mill Advantage				  
								      Mill Professional
								      Mill Expert

This tutorial is an introduction to solid model machining.

Model toolpaths are usually defined in two stages, roughing to remove 
the bulk of the material, and then a finishing method to cut the 
surface itself.  For some models a semi-finish operation, which uses a 
finish strategy with coarser settings than usual, will be useful.   

Open the sample file and save a copy.

We will open a sample file with machining already defined, and copy 
the example operations in a new toolpath group.
Open the sample file ‘mill advantage z level planar.ONECNC’, and use 
the Save As command on the file menu to save a copy of the file as 
Tutorial Mill 7 to practice in.

OneCNC Mill Tutorial 7
Model Toolpaths - Z Level Rough, Planar Finish
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There is an example Toolpath Group 
already defined in the NC manager.  

Right click on the group and select 
Simulate/Rest from the context 
menu.  

Enter the stock extents as shown in the simulation settings dialog and 
click OK.  

You will see the simulation as shown at the beginning of this tutorial.  

We will now replicate the toolpaths in a new group.

If you are using Mill Advantage, only the Traditional roughing mode 
is available for Z Level Roughing.
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Right click on the Example Toolpath 
group and select New Group from the 
context menu.

Double click on the new group name 
in the NC Manager, and rename it 
to ‘Practice Toolpath Group’ in the 
Process dialog.

Z Level Rough toolpath

Click on the Model Toolpaths icon and select the Z Level Rough 
toolpath.

In the Select Tool dialog, select the 25mm bullnose cutter from the 
Tool Changer.  Enter Tool No. 1, and select Coolant No.1 and Work 
Offset G54.  Select Aluminium Billet Stock.

For Mill Professional or Expert, select the Adjust high feedrate check 
box and enter a value of 5000.  This is the feedrate at which the tool 
repositions in a High Speed toolpath.

Click Next to continue.
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In the Clearances dialog, set the Rapid Z Plane at 5, and the Plunge 
clearance to 1.
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The next step is to select the Machining Style.

If you are using Mill Advantage, you must use Traditional.

If you are using Mill Professional or Expert, choose Highspeed Open.

Click Next to continue.



Page 211Introduction to OneCNC Mill ©

The settings in the next dialog determine how the tool enters the 
material.

For the Traditional strategy, select Plunge entry, Climb milling and 
Spiral inwards.

For the Highspeed strategy, you only need to choose Plunge entry, as 
the other factors are set by the High Speed toolpath.

Click Next to continue.
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Set Auto stepover to 25%, and leave on sides to 0.5

Clear the Leave on bottom check box.  Leave Tolerance at the default 
setting of 0.005.

For Mill Advantage set Depth of Cut to 5.5.

For Mill Professional or Expert set Depth of Cut to 15, select Reduce 
Steps and enter a setting of 1.

For the Traditional method being used in Mill Advantage, the next 
dialog will allow you to set Custom levels if desired.  For this operation 
select the Find Flat Areas option, which will create a cut level for the 
flat at the top of the block.
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The Boundary of Toolpath settings define the 3D toolpath zone.  As 
you change settings in this dialog the preview of the toolpath extents 
will update to show the effect of the changes.

Select the Extents Box boundary type.  This defines the zone by 
simple X, Y, and Z limits.  Select None for tool placement, which 
allows the cutter centerline to travel up to the boundary.

OneCNC can calculate an automatic offset from the model.

Select the Automatic Z check box, and set a value of 1 for Automatic 
Z offset.  For this model, the Automatic Z offset is necessary to allow 
the toolpath to machine the top face of the model.

Select the Automatic XY check box, and enter 0 for Automatic XY 
offset.

Click Finished to create the toolpath.

Note:
 
If the Picked boundary type is selected, you will only have Z options 
at this stage.  The XY area of the toolpath is then defined by picking 
a geometry boundary. 
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Simulate the new Z Level Rough toolpath and you will see the 
material removal progressing down in Z.

If you are using the Traditional toolpath strategy the roughing will 
appear with larger steps as shown.



Page 215Introduction to OneCNC Mill ©

With the Step Reduction technology included with OneCNC 
Professional and Expert you will see a result with smaller steps.
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Planar Finish toolpath

Now that we have roughed out the stock, we will use the Planar 
finish strategy, which runs the toolpath across the model surface at 
intervals.

Click on the Model toolpaths icon and select the Planar Finish 
toolpath.

Select the 16mm carbide ball mill tool from the Tool Library.
Enter Tool No. 2, and select Coolant No.1 and Work Offset G54.  
Select Aluminium Billet Stock.

Click Next to continue.
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In the Clearances dialog, set the Rapid Z Plane at 5, and the Plunge 
clearance to 1.
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The Planar Cut Options give you control over how the cut is achieved.

Set Direction to Zigzag, which allows the cutter to travel back and 
forth across the model.  Single direction cut is possible, but this 
creates longer repositioning moves.

Set Toolpath angle, Zigzag minimum clearance and Leave for finish to 
0.

Set surface tolerance, which controls how closely the toolpath follows 
the theoretical surface, to 0.005.

Select Maximum stepover and enter a value of 0.8.
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Select the Extents Box boundary type.  Select None for tool 
placement, which allows the cutter centerline to travel up to the 
boundary.

Clear the check box for Automatic Z Offset.

For Z Top, enter -7.  As the ball cutter radius is 8, this is enough to 
ensure the cutter passes over the entire shaped surface, without 
running over the edge to the flat surface.

Set Z Bottom of Job to -80.

Select the Automatic XY check box, and enter 1 for Automatic XY 
offset.

Click Finished and the toolpath will be created.  You will see a red 
outline traverse the model as the toolpath is being calculated.
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Simulate the toolpath group and you will see the Planar finish in 
action.

To complete this model the holes need to be drilled.  Right click on the 
Drill 2 Holes operation in the example toolpath group, and select Edit 
Operation to find the settings used to create it.  Use the Hole Feature 
Recognition command to recreate the drilling operation, and the 
machining will be completed.

On this model we have used Z Level Rough and Planar Finish 
toolpaths.  You have seen the Z Level toolpath descend in steps in Z, 
and the Planar toolpath increment in the XY plane.

Generally the Z level strategy is more suited to steep surfaces, and 
planar to lower angles, but of course many models will not be entirely 
one or the other and you will have to choose a strategy that best 
fits your purpose.  In some cases you may find a combination of 
strategies will provide the most efficient results.
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This tutorial is intended for OneCNC:	 Mill Advantage				  
								      Mill Professional
								      Mill Expert

Semi Finishing is the application of a Finish strategy with coarse 
settings, to prepare a roughed model for finishing.

This view shows the stages of machining for the sample we will use.  
The first operation, seen here at the front of the view, is Z Level 
Roughing which has left steps on the stock.  At the back of the view 
the Planar finish strategy has been applied.

In between these you can see the semi finishing operation, which has 
reduced the steps from the Z Level toolpath.

OneCNC Mill Tutorial 8
Model Toolpaths - Semi Finishing
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Open the sample file and save a copy.
Click on the Open icon, and navigate to the Samples folder which is 
located in the Drawings folder where you installed OneCNC.

Open the file ‘mill professional planar semi finish.ONECNC’, and use 
the Save As command on the File menu to save a copy as ‘Tutorial Mill 
8.ONECNC’
You will see in the NC Manager an example toolpath group already 
defined.     We will  copy this group and recreate the semi-finishing 
operation.

Right click on the group and select 
Duplicate Group from the context 
menu.

Rename the group to Practice 
Toolpath Group by double clicking on 
the group name and changing the 
Description in the Process dialog.  

Right click on the Planar Semi Finish 
operation in the duplicated group and 
delete it using the Delete Operation 
command on the context menu.

Planar Semi Finishing

Click on the Model toolpaths icon and select the Planar Finish 
toolpath.
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Select the 10mm carbide ball mill tool from the tool library, and enter 
Tool No. 2, Coolant No. 1 and Work Offset G54.

Select Aluminium Billet Stock from the Material list.

Click Next to continue.
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In the Clearances dialog, set the Rapid Z Plane at 5, and the Plunge 
clearance to 1.
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In the Planar Cut Options dialog, set Direction to Zigzag, and Toolpath 
angle and Zigzag minimum clearance to 0. 

Set Leave for finish at 0.5 so the toolpath is cutting at an offset from 
the surface.

 Set Surface tolerance at 0.005.

The stepover amount directly affects the quality of surface left by 
the toolpath.  For a semi finish operation we are more interested in 
material removal.  Select the Constant stepover option and enter a 
value of 3.
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In the Boundary of Toolpath dialog, select the Part boundary option.
Select None for tool placement, which allows the cutter centerline to 
travel up to the boundary.

Select the check box  for Automatic Z Offset, and enter a value of 1.
Click Finished and the toolpath will be created.

The new operation is added to the end of the toolpath group.  We will 
move it to the correct position, but to make sure we do not confuse 
the semi finish and finish operations, we will rename the operation 
before doing so.

Double click on the operation name 
and change the Description in the 
Process dialog to 2:Planar Semi 
Finish. 
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With the cursor over the new 
operation, hold down the left mouse 
button and move the operation up 
until a line appears between the 
Z Level Rough and Planar Finish 
operations.

Let go of the mouse button and the 
operation will be inserted where the 
line appeared.

Simulate the toolpath group and you will see the semi finish operation 
after the initial roughing is complete.
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This tutorial is intended for OneCNC:	 Mill Professional, Mill Expert

The Multiple Parts  tab in the NC Processing dialog has functions which 
allow you to define toolpaths for a single part, and then specify copies 
of the toolpaths to cut as many copies of the part as you need.  

Repeats can be applied to individual operations or complete toolpath 
groups.

There are two methods of writing repeats in the NC file.

Standard repeats are written in full in the NC file.  This is simple for 
the operator but can create large files.

For subroutine repeats, OneCNC writes one NC file with each of the 
original toolpath operations written once as a separate subroutine.  
The subroutines are then called as required for each position using a 
work offset.

OneCNC Mill Tutorial 9
Multiple Parts
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Standard repeats / one work offset

Can be applied to a toolpath group or a single operation.
OneCNC writes the toolpath for each repeat operation, using the same 
program origin position.  Because each operation is written completely 
for each position, OneCNC can rotate the repeated toolpath if desired.

The standard repeats method will create a larger NC file.  If your 
machine has the capability, you can use a subroutine method.

Subroutine / vices / multiple work offsets
Can only be applied to a toolpath group. The repeats defined with 
this method are used for vice positions assigned to individual G codes 
such as G54 , G55, and so on.

Each subroutine will be run at each location, by writing the work 
offset G code (G54, G55 etc) for each location before each subroutine 
call.  As the offset positions are set on the machine and not in 
OneCNC, the machine operator must set the offsets correctly, and this 
method cannot be backplotted or simulated.

On a Heidenhain controller, use the ‘one work offset / G52’ subroutine 
method instead, which the Heidenhain Post will convert to a CYCLE 
DEF 7 Datum Shift.
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Subroutine / multiple parts / one work offset / G52
Can only be applied to a toolpath group.

Like the multiple offsets method, OneCNC writes each of the toolpath 
operations as a separate subroutine in one NC file.  Each subroutine 
will run at each offset location, which will be written to the G52 work 
offset.  This method can be backplotted or simulated.

Defining repeats

To practice defining repeats, open the ‘spacer block.ONECNC’ sample 
file, and save a copy as ‘Multiple parts tutorial.ONECNC’

In the NC manager, there is an 
example toolpath group to machine 
the block.  We will use the repeat 
functions to generate copies of the 
toolpaths in this group.
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The first step when defining repeats is to find the spacing between 
parts, which must allow for the diameter of the cutter used to cut the 
part profile, and any leave for finish or lead-in/lead-out values.

Before continuing, we will minimise the lead-in and lead-out settings 
for the part profiling operation.  Double click on the ‘Outer Mill Profile’ 
operation, and click on the Edit Operation icon in the NC Processing 
dialog.  Step through the dialogs without making any changes till you 
reach the Entry/Exit Conditions page.
Change the Leadin Radius to 1, and Leadin Angle to 45.  Change the 

Start Line Length to 1 and set the Start Line Angle at 0.  Copy the 
Entry values to the Exit values input boxes, and click Finished.

The required array distance can now be found by backplotting the 
profile operation and measuring using the Verify tools.  For this part 
we will round the distance up to 180 in X and 130 in Y.

Create 3 duplicates of the original 
toolpath group, and name them 
Standard Repeats, Multiple Offset, 
and Single Offset.
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Standard repeats

Double click on the heading of the Standard Repeats toolpath group, 
and select the Multiple Parts tab in the NC Processing dialog.

For this exercise, select the standard repeats option, and click on the 
copy array button to open the array dialog.

We will now make array copies of the part, using the spacing we 
determined earlier.  Enter 2 for number of parts in Y, with a Y distance 
of 130.  Enter 2 for number of parts in X, with an X distance of 180.

Click OK and you will see the original position and the three repeats 
listed in the Positions pane of the Multiple Parts tab.
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Selecting a position will show the instant preview of the toolpath in 
the drawing window.  You can double click on a repeat in the positions 
list to rename it.  For a backplot of an individual repeat, select the 
repeat and click the Backplot icon.

Click OK to close the NC Processing dialog.  You will see ‘x3’ after the 
title of the group, indicating the number of repeated positions.

Simulate the toolpath group, using the Extents option for stock 
definition.

Select the check box for 
Automatic Offset, and set it 
and Top of Job to 0.
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You will see how the simulation sets the simulation stock to include 
the repeats.

When a toolpath group is repeated, each operation is carried out 
at each repeat location before processing continues to the next 
operation, reducing the number of tool changes.

Here you can see the pocketing has been carried out for each repeat 
before the hole feature operation begins.
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Subroutine repeats using multiple offsets

To use the multiple offsets method, it is only necessary to specify the 
number of vices or positions required, and assign the offsets to the 
repeats.

Double click on the Multiple 
Offsets toolpath group, and select 
the Multiple Parts tab in the NC 
Processing dialog.

Select the subroutine / vices / multiple work offsets option.
Enter 4 in the input box which appears for Number of vices.
You will see the repeats appear in the Positions pane of the dialog.

This method is not suitable for use with a Heidenhain controller.  
Use the ‘one work offset / G52’ subroutine method instead, which 
the Heidenhain Post will convert to a CYCLE DEF 7 Datum Shift.
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To assign an offset 
position to a repeat, 
select the repeat in 
the Positions window, 
and then select the 
offset code in the 
Work offset box.  Here 
we are assigning G55 
to the first repeat 
after the original 
position.  The offset 
will appear after the 
repeat name.  

Assign G56 to the 
next repeat, and G57 
to the last repeat.

Click OK to confirm the specified 
repeats.  The x3 symbol will appear 
in the Toolpath Group title bar, 
indicating the original position will be 
repeated 3 times.

As we have only selected the work offsets for each repeat by their 
relative codes, which must be set on the machine itself, OneCNC has 
no information about the actual repeat position.

This means when defining repeats in this way it is only possible to 
backplot or simulate the original position.

If you are not the machine operator, you must provide accurate 
information for the toolpath size with the NC file so each repeat 
position can be located on the machine with sufficient spacing.

Backplot the part and measure the toolpath, including any lead-in or 
lead-out present.
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Subroutine repeats using a single offset

Subroutine repeats defined by re-writing the same offset each time 
are defined in the same way as standard repeats, but can only be 
copy array or copy move repeats.

Double click on the Single Offsets 
toolpath group, and select the 
Multiple Parts tab in the NC 
Processing dialog.

This time select the subroutine /  one 
work offset / G52 option.

Click on the copy array icon and define the same array as before, for 
2 parts in each direction, with a Y distance of 130, and an X distance 
of 180.

Having a correctly formatted Post for your machine is essential 
for the subroutine methods.  Detailed information about posting 
formats for various machines is available in the Mill> Multiple Parts 
section of OneCNC Help.
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The repeats appear in the Positions menu as before.

There is no need to enter the Work offset code as this is handled 
automatically in the Post.

This method can be backplotted and simulated in the same way as 
for standard repeats, as the array distances have been defined in 
OneCNC.  The difference between the two methods will only become 
apparent when the NC file is posted.

Output for individual repeats can be turned on and off by clicking 
the On/Off icon in the Multiple Parts tab.

If you have tested your toolpaths in the original position, you can 
turn off the output for that position to save time when you run the 
repeats on the machine.
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This tutorial covers toolpaths only available in Mill Expert

In this tutorial we will describe the advanced machining strategies 
provided by Mill Expert.

		Roughing strategies			   Finish strategies

Plunge				  
Radial				    Radial
Spiral				    Spiral
Custom				    Custom
						     Area Machining
						     Valley Machining
						     Z Level Complete
						     Undercut
						     Constant Offset
						     Offset 
						     Pencil tracing
						     Planar steep
						     Planar shallow

Detailed guides to these toolpaths are 
provided in the Mill SMT 3D Toolpaths 
section of OneCNC Help.

By this stage you should be familiar with 
the common OneCNC toolpath wizard 
settings, and we will only describe the 
features of each strategy, and the situations 
suited to their use.

OneCNC Mill Tutorial 10
Advanced Solid Model Toolpaths
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Plunge Roughing

Plunge roughing is a highly effective material removal strategy which 
drives the cutter down in the Z axis at increments in X and Y.

When used with a suitable tool, which must be able to end cut and 
remain centered, plunge roughing virtually eliminates lateral flexing of 
the cutter.

There are two options to select from for the plunge roughing stepover.
Conventional calculates the X and Y stepover based on the tool size.
Manual activates input boxes so you can enter the  stepover values 
you want to use.

To see an example of plunge roughing, open the sample file ‘mill 
expert plunge rough machining.ONECNC’, and simulate the sample 
toolpath group. 
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Radial Roughing

Radial Finishing

Parts with surfaces revolved about an axis parallel to the Z axis are 
suited to Radial machining, especially when the surface slope is 
towards or away from the center of revolution.

When you define a Radial toolpath you will be prompted for a center 
for the radial moves, which must be defined as a point entity.

The tool travels over the model on lines which radiate from a center. 
Each pass is offset by a degree increment entered in the Radial 
Options dialog, where you can also specify a start and finish angle.

The radial strategy is not as efficient near the center of the toolpath 
as the radial offsets become closer and the effective stepover reduces.

To see how radial machining works, open the sample file ‘mill expert 
radial finish.ONECNC’, and open the Radial Finish toolpath for editing 
so you can see the settings used.
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Spiral Roughing

Spiral Finishing

The application of spiral toolpaths is similar to radial toolpaths.
It is most suited to parts which do not have a steep surface slope 
towards or away from the center of revolution.

When you define a Spiral toolpath you will be prompted for the center 
of the spiral toolpath, which must be defined as a point entity.

The tool follows a spiral path around the part.  The spiral expands 
with a constant stepover amount which is defined in the Spiral 
Options dialog.

To see spiral machining in action, open the sample file ‘mill expert 
spiral machining.ONECNC’.  You will see a Spiral Finish operation in 
the NC Manager.
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Custom Roughing

Custom Finishing

Custom Roughing and Finishing toolpaths give you a powerful method 
of model machining by using geometry drawn in 2D to define the XY 
travel of a toolpath on a 3D model.

To machine the surface, draw the 2D geometry you want the toolpath 
to follow on a separate layer so it can be selected easily.  The 
geometry can be drawn manually, or generated by a hatch pattern or 
backplot of any 2D operation.

When you generate the toolpath you can select the geometry by layer.

The toolpath can have an optional engrave distance so it will cut into 
an existing model.

This example shows a hatch pattern engraved onto an existing 
surface.
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Area Machining

Area Machining is a unique strategy for machining surfaces which 
automatically generates a 3D boundary of a set of surfaces.

Area machining requires the selection of one or more surfaces that 
are adjoining and clear from other objects.

The surfaces are then machined by offsetting the 3D boundary over 
the surfaces.

Area Machining is not suitable for machining a vertical face on its 
own, as the 3D offset would cause the tool to spiral around, cutting 
on the full side of the tool. It is possible however to machine a vertical 
face when it is selected together with other curved surfaces, as the 
3D offset generated will be more suitable.
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Valley Machining

Valley Machining is designed for specialized finishing of intricate parts.  
Larger tools can be used for roughing and finishing parts with internal 
fillets, then the fillets can be finished with a smaller ball mill by Valley 
Machining.

The strategy will generate multiple passes to finish any fillets with a 
radius equal to or smaller than the tool.

When you define a Valley Machining operation, OneCNC automatically 
identifies any fillets with a radius that can be machined with the 
selected ball mill, and creates toolpaths to clean up those fillets.

Open the sample file ‘1_valley machining 3axis.ONECNC’ to see an 
example of Valley Machining in use.

The sample model has 1.9mm radius fillets around the webs, which 
can be finished using Valley Machining.

Click on the example Valley Machining operation in the NC Manager 
and you will see it uses a 3mm diameter ball mill tool.
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Z Complete Finishing

Z Level Complete finishing is similar to Z level finishing, but when the 
toolpath finds surface areas which are level or near level, the strategy 
automatically changes to an offset toolpath to finish those areas.

It is suited to parts which have a combination of steep and flat areas.

Defining a Z Level Complete toolpath is similar to defining a Z Level 
toolpath.

The Z level increments can be specified as Constant Depths or 
Maximum stepover.  The value entered will also determine the 
horizontal stepover used on flat areas when the toolpath changes 
from Z Level to Offset machining. 
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Undercut Finishing.

Undercuts can be made by the use of a spherical ball mill, or ‘lollipop’ 
tool, which has a shank diameter smaller than the ball diameter.

OneCNC prevents the shaft from contacting the part, so the amount 
of undercut possible is determined by the tool size.

To see an Undercut toolpath in action, open the sample file ‘3_axis_
lollipop.ONECNC’, and simulate the toolpath.

This image shows a sectioned view of the simulation.  The axis of the 
hole is 5 degrees from vertical, meaning the right side of the hole 
cannot be cut with a normal end or ball mill.

The Select Tool dialog for this strategy has a setting for Shaft 
clearance, which is the clearance used by OneCNC to prevent the 
shaft from contacting the model.

When defining an undercut toolpath, the Position dialog will appear so 
you can select a retract position at a safe distance from the overhang.  
It is recommended that you draw a point entity to use for the retract 
position.
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Constant Offset

By using a boundary similar to the shape of the part, Constant Offset 
Machining can create a uniform toolpath over the machined area.  

Because the boundary controls the flow of the tool path it is possible 
to create a good machining flow over part shapes which are otherwise 
difficult to machine.

Vertical faces are not suitable for Constant Offset Machining, these 
can be done more efficiently with Mill Profile or Z Level finishing. Most 
mould work does not have true vertical faces anyway, a taper of just 
1 degree means it is not a vertical face and is suitable for Constant 
Offset Machining.
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Offset Finishing

Offset machining cuts the part model in passes offset at a regular 
stepover from a boundary.

This toolpath is useful for unusual shapes or shapes with large or 
irregular openings.

To define an Offset toolpath you will need an outer boundary, and you 
can also select inner boundaries to define islands you do not want 
machined.  The boundaries must be closed chains of entities but can 
be 2D or 3D.  One click on any entity in a closed chain will select the 
entire connected boundary.

When the toolpath is generated, passes are made at offsets from the 
boundaries across the model surface.  The stepover is defined in the 
Offset Path Options dialog and is the maximum stepover across the 
model surface.
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Pencil Trace Finishing

The Pencil Trace toolpath strategy is designed to identify and pencil 
finish fillets using a ball mill.

The strategy will generate a single pass to finish any fillets with a 
radius equal to or smaller than the tool.

When you define a Pencil Trace operation, OneCNC automatically 
identifies any fillets with a radius that can be machined with the 
selected ball mill, and creates single pass toolpaths to clean up those 
fillets.

Open the sample file ‘pencil_mm.ONECNC’ to see an example of the 
Pencil Trace operation.

The sample model has 3mm radius fillets around the bases of the 
cylinders, which can be finished using Pencil Tracing.

Click on the example Pencil Tracing operation in the NC Manager and 
you will see it uses a 6mm diameter ball mill tool.
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Planar Steep Wall Finishing

Planar steep finishing is designed to cut specific areas of the part 
model based on their angle from the horizontal plane.

This toolpath strategy is optimized for areas with a steep wall angle.

The settings for Planar Steep Wall machining are similar to the Planar 
Finishing toolpath, with the addition of settings for slope Start Angle 
and slope Finish Angle.  Any part of a surface in the toolpath zone 
which has a steepness angle within these limits will be machined.

The areas are cut in parallel passes like a planar finishing cut.  The 
angle of the passes from the X axis can be changed to suit the job.  
There is an additional option to make passes at right angles to the 
basic angle where that direction would be more suitable for the slope.
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Planar Shallow Finishing

Planar shallow finishing is designed to cut specific areas of the part 
model based on their angle from the horizontal plane.

This toolpath strategy is optimized for areas with a shallow wall angle.

The settings for Planar Shallow machining are similar to the Planar 
Finishing toolpath, with the addition of settings for slope Start Angle 
and slope Finish Angle.  Any part of a surface in the toolpath zone 
which has an angle from the XY plane within these limits will be 
machined.

The areas are cut in parallel passes like a planar finishing cut.  The 
angle of the passes from the X axis can be changed to suit the job.  
There is an additional option to make passes at right angles to the 
basic angle where that direction would be more suitable for the slope.  
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For assistance contact the OneCNC office for your location.

If you are emailing a support question, it will help us to help you if 
you zip and attach the file you are having a problem with, and include 
the following information:

Client Number
Click on Help > About OneCNC.  Your client number is a five digit 
number with the prefix CN. The number is the same as your dongle 
number.

Version
Click on Help > About OneCNC to find the exact version you are 
running, e.g. 51.10

OneCNC product
The type and level of OneCNC such as Mill Expert.

Units
Please let us know if the file is drawn in metric or imperial units.

OneCNC Support
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Australia
				   OneCNC Australia

		  Phone 		  +61 (0)7 3286 2527
		  Fax 		  +61 (0)7 3286 4992
		  Email		  support@onecnc.com.au
		  Internet	 www.onecnc.com.au 

Benelux
				   OneCNC Benelux

		  Phone		  +31 (0) 40 22 66 212
		  Fax		  +31 (0) 40 22 40 794
		  Email		  support@onecnc.nl
		  Internet	 www.onecnc.nl 

Denmark
				   OneCNC Denmark

		  Phone		  + 45 20 40 02 68
		  Fax		  + 45 20 40 02 68
		  Email		  support@onecnc.dk
		  Internet	 www.onecnc.dk  

France
				   OneCNC France

		  Phone		  + 33 (0)4 72 33 38 74
		  Fax		  + 33 (0)4 72 91 42 92
		  Email		  support@onecnc.fr
		  Internet	 www.onecnc.fr

Germany
				   OneCNC Germany

		  Phone		  +49(0)5261 288940
		  Fax		  +49(0)5261 2889449
		  Email		  support@onecnc.de
		  Internet	 www.onecnc.de

India
				   OneCNC India

		  Phone		  +61 7 3286 2527
		  Email		  support@onecnc.com.au
		  Internet	 www.onecnc.in

Indonesia
				   OneCNC Indonesia

		  Phone		  +62 31 8411187
		  Email		  support@onecnc.id
		  Internet	 www.onecnc.co.id

OneCNC Global Offices
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Ireland
				   OneCNC Ireland 

		  Phone		  +353 7196 33200
		  Fax		  +353 7196 33500
		  Email		  support@onecnc.co.uk
		  Internet	 www.onecnc.co.uk 

Italy
				   OneCNC Italy

		  Phone		  +39 393 438 3373
		  Fax		  +39 178 271 6215
		  Email		  support@onecnc.it
		  Internet	 www.onecnc.it

Japan
				   OneCNC Japan

		  Phone		  +81 (0)72 760 3134
		  Fax		  +81 (0)72 760 3135
		  Email		  onecnc@onecnc.co.jp
		  Internet	 www.onecnc.co.jp 

Korea
				   OneCNC Korea

		  Phone		  + 82 31 695 7250
		  Fax		  + 82 31 695 7253
		  Email		  support@onecnc.kr
		  Internet	 www.onecnc.kr

Mexico
				   OneCNC Mexico

		  Phone		  +52 (55) 85017429
		  Email		  esanchez@onecnc.com.mx
		  Internet	 www.onecnc.com.mx 

Portugal
				   OneCNC Iberia 

		  Phone		  +34 936 473 117
		  Email		  josep.soler@1cnc.es
		  Internet	 www.onecnc.es

Poland
				   OneCNC Poland

		  Phone		  +48(0)22 388 3460
		  Fax		  +48(0)22 388 3461
		  Email		  support@onecnc.pl
		  Internet	 www.onecnc.pl
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South Africa
				   OneCNC South Africa 

		  Phone		  +27 31 7014732
		  Fax		  +27 31 7014736
		  Email		  sredman@iafrica.com
		  Internet	 www.onecnc.net

Spain
				   OneCNC Iberia 

		  Phone		  +34 936 473 117
		  Email		  josep.soler@1cnc.es
		  Internet	 www.onecnc.es

Sweden
				   OneCNC Sweden

		  Phone		  +46 (0)35-7777030
		  Fax		  +46 (0)35-7777031
		  Email		  support@onecnc.se
		  Internet	 www.onecnc.se

Taiwan
				   OneCNC Taiwan

		  Phone		  + 886 2 26665010
		  Fax		  + 886 2 26660917
		  Email		  chou@wvision.asia
		  Internet	 www.onecnc.com.tw

United Kingdom
				   OneCNC UK

		  Phone 		  +44 (0) 190 237 3054 
		  Fax 		  +44 (0) 190 237 5593
		  Email		  support@onecnc.co.uk
		  Internet	 www.onecnc.co.uk

USA
				   OneCNC LLC

		  Toll Free	 +1 877 626 1262
		  Phone		  +1 813 874 2335
		  Fax		  +1 813 874 2919
		  Email		  support@onecnc.com
		  Internet 	 www.onecnc.com 

USA California
				   OneCNC West

		  Phone		  +1 909 931 7811
		  Fax		  +1 909 985 6967
		  Email		  support@onecncwest.com
		  Internet 	 www.onecncwest.com 
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Copyright Notice

Copyright © 2017     All Rights Reserved 

This publication or parts thereof, may not be reproduced in any form, 
by any method, for any purpose.

Trademarks

The following are registered trademarks of QARM Pty Ltd, in Australia 
and/or other countries: OneCNC XR7, OneCNC XR6, OneCNC XR5, 
OneCNC XR4, OneCNC XR3, OneCNC XR2, OneCNC XR, OneCNC XP, 
OneCNC 2003, OneCNC 2000, OneCNC, AusWire, AusMill, AusCAD, 
AusCADCAM, NCSentry, NCLink.

Third-Party Trademarks

All other brand names, product names or trademarks belong to their 
respective holders.

QARM Pty Ltd. MAKES NO WARRANTY, EITHER EXPRESSED 
OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE, REGARDING THESE MATERIALS AND MAKES SUCH 
MATERIALS AVAILABLE SOLELY ON AN “AS-IS” BASIS. IN NO 
EVENT SHALL QARM Pty Ltd BE LIABLE TO ANYONE FOR SPECIAL, 
COLLATERAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IN 
CONNECTION WITH OR ARISING OUT OF PURCHASE OR USE OF 
THESE MATERIALS. THE SOLE AND EXCLUSIVE LIABILITY QARM Pty 
Ltd., REGARDLESS OF THE FORM OF ACTION, SHALL NOT EXCEED 
THE PURCHASE PRICE OF THE MATERIALS DESCRIBED HEREIN.

QARM Pty Ltd reserves the right to revise and improve its products as 
it sees fit. This publication describes the state of this product at the 
time of its publication, and may not reflect the product at all times in 
the future.

Copyright Notice
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